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1 WELCOME TO CONTROL CENTER

Control Center overview
IndigoVision's Control Center is a powerful and easy-to-use software solution that enables
you to manage all your video surveillance operations and investigate security events
quickly and effectively in one integrated platform.

The Control Center suite consists of a number of applications that provide a complete end-
to-end IP security solution. These applications include the NVR-AS and the Control Center
front-end application.

The Control Center front-end application enables all users (subject to access permissions)
to carry out the following tasks:

View live video

• Display live video on one or more PC screens, in a variety of layouts.
• Display live video from any networked camera on analog monitors.
• View live video from ONVIF cameras.
• Listen and speak to people you view on screen.
• Use sequences to view a set of cameras in succession in one video pane or analog

monitor.
• Use salvos and guard tours to view a set of cameras in consecutive video panes or

analog monitors.
• Use the CCTV keyboard to display video from cameras, sequences salvos and

guard tours on video panes and analog monitors by number using a CCTV
keyboard.

• Control a PTZ camera using the on screen joystick and/or a CCTV keyboard.
• Record live video and take snapshots of images.
• Use maps to quickly locate cameras you want to view.
• Perform relay actions, e.g. open door, turn on light directly from the video pane.
• Use Pursuit Mode to follow subjects of interest from one camera view to an adjacent

camera.

View recorded video

• Search through past recorded footage.
• Review recorded footage using thumbnail images by time, alarm, bookmarks,

activation and motion.
• Play back recordings.
• Record and review recordings from ONVIF cameras.
• Use digital zoom to view footage in more detail.
• Save snapshots and recordings to file as evidence.
• Export and protect recordings.
• Save recordings as incidents.
• Play back exported recordings or incidents.
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• Find motion in sections of recorded footage.

View and deal with alarms

• View, and acknowledge all alarms that have occurred on your sites.
• Black screen monitoring of alarms.
• Carry out actions when an event occurs.
• Play back recordings associated with alarms.
• View alarm history and search for alarms.
• Generate reports about alarms.
• View an alarm procedure
• View live video of the scene where an alarm has occurred.
• Display a map of the site where an alarm has occurred.

Control Center enables administrators to carry out the following tasks:

Set up and configure Control Center

• Create and administer user groups and accounts (requires full administrator
permissions).

• Create sites and organize cameras, analog monitors, NVRs, and Alarm Servers into
a hierarchy within sites.

• Create sequences, salvos and guard tours within sites.
• Specify users’ access permissions on sites and the objects within them.
• Set up detectors and zones.
• Set up alarm notification and actions on events (alarms or detector activations).
• Manage recordings and alarms.
• Set up transmitters and receivers using their Configuration pages.
• Associate maps with sites, and add cameras, zones and detectors to maps
• Number cameras and monitors, sequences, salvos and guard tours for use with the

CCTV keyboard.
• Set up an IP Video Wall (requires an additional license)

Using the interface
You can often use the mouse, the toolbar or the menu bar to carry out the same action in
Control Center . Some actions can also be performed using keyboard shortcuts. The
shortcut key combination is displayed next to the relevant menu option.

For simplicity, this help usually outlines a single method. For example, to play live video
from a camera in a PC pane, you can do any of the following:

• Double-click the camera name in the Video explorer.
• Drag-and-drop the camera from the Video explorer into the video pane.
• Select a camera in the Video explorer, then choose Live Video>View Camera in

Pane.
• Right-click a camera in the Video explorer, then choose View Camera in Pane.

Although there may be several ways of carrying out an action, the quickest, most
convenient method is described in this help.

1 Welcome to Control Center Control Center
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Conventions used
The following visual indications are used in this document to help you locate and identify
information quickly.

Additional information relating to the current section.

Potential hazard that could seriously impair operations.

Control Center online help
Control Center has a comprehensive online help system that provides an overview of key
concepts used by Control Center and details the user interface.

The help is divided into Operator and Administrator level topics.

The How do I... sections contain details of everyday tasks.
The Troubleshooting sections contain problem solving information.

To access the Control Center online help, press the F1 key. Alternatively, many of Control
Center's dialogs contain a help button. Click the Help button on the dialog to view useful
information about using the dialog.

To search the help system for a particular word or phrase, for example, "view live video",
click the Search tab, then type the text you want to find. Click List Topics, then double-click
the topic you require from the list.

Green, bold text indicates additional information is available. Click the text to reveal the
additional information.

Control Center 1 Welcome to Control Center
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2 CONCEPTS OVERVIEW

Live overview
Control Center’s Live view enables you to view live video on the PC screen, on analog
monitors and on VCRs, in a variety of different layouts. You can also:

Record live video.
Interact with people you see on screen.
Take snapshots of video footage.
Control PTZ cameras.
Perform a relay action when viewing video.
Use sequences to view video from cameras in succession.
Use salvos to quickly display frequently-viewed cameras.
Use guard tours to display sequences of salvos.
Take an action when an alarm occurs.
Show analytics in live video.
Use Pursuit Mode to follow subjects of interest.

Recordings overview
Control Center enables you to create and play back recordings. All users can record live
video , while administrators can specify that recording should take place when certain
conditions are met (for example, at a certain time, or when an event occurs).

Use the Playback view to review recorded footage. This view displays up to 25 panes
where the video footage can be played back. You can choose to play back each recording
separately, or to play them all back from the same time - synchronized mode.

The timeline indicates the times for which footage is available for a particular camera. You
can also view thumbnails of the recorded footage in the video pane.

Sites overview

If you are using Control Center as an operator
Details of all cameras that you are required to observe and monitors and VCRs that you
may use are contained in one or more sites. When you open Control Center, all sites and
cameras that you are authorized to view are shown in the Video explorer, and alarm zones
and detectors in the Alarms explorer. Analog monitors and VCRs are shown in the
Monitors Pane.

You have a home site which is the site that you are currently monitoring.
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Video explorer Alarms explorer

The Video explorer displays cameras, salvos and sequences within your home site. You
can change your home site if required.

You can search through the site database using the Site Search window. The Site Search
window can be viewed in Live and Playback view

If you are using Control Center as an administrator
In Control Center, a site is a set of devices typically in a common location or region.

Control Center stores site information in a database. This database is created during the
installation process, and contains information on all the sites you create. It allows all users
to view the sites they have access to.

The Explorer panels display all sites and their contents, as shown below.

2 Concepts overview Control Center
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Video explorer Alarms explorer Users explorer

Administrators can view all devices in all sites in the Video explorer, and configure them.
They can also specify which sites other users are authorized to view, and organize sites
into a hierarchy to allow for easy navigation. There is no limit to the number of levels of sub-
site a site can have. However, IndigoVision recommends that you have no more than five
levels of sub-sites.

You can search through the site database using the Site Search window.

When creating sites, please note the following:

A device can only belong to one site. If you have added a device to one site, and then add it to another, the
device is automatically removed from the first site.
You can drag-and-drop devices from one site to another.
You can drag-and-drop sites within the Video and Alarms explorers.

Site database overview
The Control Center site database stores the site configuration information. Control Center
is configured to connect to a Site Database Server during installation. You can re-configure
Control Center to use a different Site Database Server at any time by using the Control
Center Setup tool.

To open the Control Center Setup tool outside of the installation process, from the Start
menu select Programs > IndigoVision > Control Center Setup.

There are two components to a Control Center site database:

• The Site Database Server which hosts configuration information for users and
cameras. This is provided as a network service.

• The Site Database Files which hosts additional media files such as maps and audio
messages. This is provided as a Windows file share.

Control Center 2 Concepts overview
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It is recommended to host the Site Database Files on the same PC as the Site Database
Server.

► For more information on the Site Database Server, please refer to the Site Database
Server Admin Guide.

Users and groups overview
To access the Control Center front-end application you require a user account. Each user
account is assigned a user name and a password that are required to log on to Control
Center.

All user accounts are organized into groups. There are three group roles:

• Full Administrator: Users in groups with the full administrator role have access to all
Control Center functionality.

• Restricted Administrator: Users in groups with the restricted administrator role have
access to all Control Center functionality, except that they cannot create, modify or
delete users. However, they can create or edit user tasks.

• Operator: Users in groups with the operator role have access to only Live and
Playback views. Administrators can also define operator access permissions to site
objects.

Groups help administrators manage users by enabling operator access permissions and
settings for multiple users to be changed in one place.

To view or control a site object in the Video explorer, for example, a camera, users require
the correct access permissions for that object, and the object's parent. Administrators can
set explicit access permissions for operator groups.

Each user in a group inherits the values from their group. However, administrators can set
explicit access permissions and settings for individual users - these override the group
settings for that user.

User and group access permissions set for a site are inherited by the objects in that site
unless explicit access permissions are granted to an object.

What are object 

permissions for

User

What are object 

permissions for

Group

Which permissions 

are used for 

this object? 

What are default 

permissions for 

Object

User Permissions Group Permissions Default Permissions 

Inherit

Explicit

Inherit

Explicit

Inherit

Explicit

Users and Groups

Repeat for 

Parent Site

The top site always has explicit permissions defined, therefore, if no explicit access
permissions have been set, Control Center uses the default access permissions defined for
the top site.

For example, in the scenario below, when the users access the camera called Stairs in the
Internal site, the users are granted the following access permissions:

• Alice: List - Inherited from the top site default as no explicit permissions are set for
this user or their group.

• Bob: List, View - Inherited from the Internal team group as no explicit permissions
are set for this user.

2 Concepts overview Control Center
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• Claire: List, View, Control - Explicit permissions are set for this user.
Users and Groups Site Objects Permissions

Users and Groups Acme Towers List

Internal Inherit (List)

Stairs Inherit (List)

External Stairs Inherit (List)

Alice Stairs Inherit (List)

Internal team Stairs Explicit - List, View

Bob Stairs Inherit (List, View)

Claire Stairs Explicit - List, View, Control

Users and groups example: opting out
In the following example, the default access permissions have all permissions selected,
and then specific permissions are removed as required. This scenario is useful where
users are allowed to perform all actions, but only need to access a sub-set of the site.

Example
The security staff for Acme Towers are divided into two teams, internal and external, which
are jointly supervised by managers.

The default access permissions have all options enabled, and the following operator
groups are created:

Groups Site Objects Permissions

Users and Groups Acme Towers All

Internal Inherit (All)

External Inherit (All)

Managers Acme Towers Inherit (All)

Internal Inherit (All)

External Inherit (All)

Internal team Acme Towers Inherit (All)

Internal Inherit (All)

Control Center 2 Concepts overview
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External Explicit - None

External team Acme Towers Inherit (All)

Internal Explicit - None

External Inherit (All)

The users in these groups will see the following objects in the Video explorer:

Managers Internal team External team

For a trial project, a member of the Internal team, Dave, requires temporary access to view
video from the Entrance camera. So the Administrator explicitly grants Dave access to view
that camera, such that his permissions are:

User and Group Site Objects Permissions

Dave Acme Towers Inherit (All)

Internal Inherit (All)

External Explicit - List

Entrance Explicit - List, View

All other objects Explicit - None

Dave will now see the following objects in the Video explorer:

Internal team: Dave

2 Concepts overview Control Center
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Users and groups example: opting in
In the following example, the default access permissions have none of the permissions
selected, and then specific permissions are granted as required. This scenario is useful
where different classes of users require different levels of access.

Example
The security staff for Acme Towers are divided into two teams, internal and external, which
are jointly supervised by managers.

The default access permissions are set to List , and the following operator groups are
created:

Groups Site Objects Permissions

Users and Groups Acme Towers None

Internal Inherit (List)

External Inherit (List)

Managers Acme Towers Explicit - Enable all

Internal Inherit (All)

External Inherit (All)

Internal team Acme Towers Inherit (None)

Internal Explicit - Enable all

External Explicit - None

External team Acme Towers Inherit (None)

Internal Explicit - None

External Explicit - Enable all

With the top site permissions, Acme Towers, set as None for the Internal and External
groups, these groups will not be able to access this site. Therefore, the home site for each
group is set as follows:

• Managers: Acme Towers (top site)
• Internal: Internal
• External: External

The operators in these groups will see the following objects in the Video explorer:

Managers Internal team External team

Control Center 2 Concepts overview
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Alarms overview
The IndigoVision Control Center can be configured to detect alarms when any of the
following occur:

A trigger device is activated (for example, a pressure-sensitive pad is activated, or a window is broken).
Actions are detected by a camera using video analytics (for example, motion).
External systems are activated.
A fault is detected with a device (for example, network connection is lost).

Detectors are configured in Control Center to activate when events are captured by
devices such as PIRs, pressure-sensitive pads, or cameras. Detectors are grouped into
zones. Zones organize detectors into logical groups, for example, one floor of a building, to
help manage alarms more effectively.

When a detector is activated, it triggers an alarm in the zone. If more than one detector in a
zone is activated before the alarm is cleared, no further alarms are triggered.

Two detectors can be combined as a double knock detector that is activated when both
detectors are triggered. For example, the detector activates when a door opens and motion
is detected.

A schedule can be applied to zones and detectors to specify when they are active and,
therefore, when alarms can be triggered.

An alarm is indicated by a flashing alarm icon in the Alarm status bar and the alarm
appears in red type in the Alarms panel. The detectors that activated the alarm are also
displayed in the Detectors tab. Other methods may also be used to indicate that an alarm
has occurred.

To ensure alarms are responded to in a timely manner, you can configure the system to
escalate alarms. If an alarm has not be responded to within the defined timeout period, the
system escalates it by bringing it to the attention of another group of users.

Events and subsequent detector activations are captured and filtered by an alarm server,
and passed onto Control Center. They are stored on the same alarm server. Alarms can
also originate from other external systems and be filtered by an alarm server.

CCTV keyboards overview
Control Center currently supports the:

2 Concepts overview Control Center
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IndigoVision v1 Keyboard
IndigoVision Surveillance Keyboard
Pelco KBD300A Universal Keyboard (version 5.20 keyboard firmware and later)
Pelco CM9760-KBD Intelligent Keyboard
American Dynamics ADCC1100 Keyboard
American Dynamics AD2088 Keyboard (labelled Sensormatic)
Panasonic WV-CU650 Keyboard

You can use keyboards to:

Control cameras
Display cameras, salvos, sequences and guard tours on the PC screen or on analog monitors

Administrators only - To allow users to carry out these functions, you must configure basic
numbering options. See Numbering Overview for details on how Control Center allocates
numbers.

Authentication overview

This functionality is only available if you have administrator permissions.

When you create a user account, you must specify the method that user uses to log in:

Windows authentication:When this user tries to log in, Control Center checks that the current Windows
user is the same as the Windows user linked to that user account. If it is the same user, they are logged in; if
not, an error message is displayed and the user is not logged in.
Password authentication: The user must enter this password each time they log in to Control Center. You
can create operator accounts without a password, if required.

When Require users to enter their password when logging out of or exiting Control
Center is selected in the User Management dialog, users with password authentication
must enter a password before they can log out or exit Control Center. This restriction does
not apply to users with Windows authentication.

ONVIF overview
ONVIF is an open industry forum for the development of a global standard for the interface
of IP-based physical security products. Control Center supports devices conformant with
the ONVIF 1.02 standard.

Control Center supports the following features for ONVIF devices:

• View live video
• Listen to live audio
• Record and play back video and audio
• Export footage recorded from ONVIF devices
• Control PTZ cameras

Control Center 2 Concepts overview
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• Add and view bookmarks on footage recorded from ONVIF devices
• Recording video on an event
• MPEG-4 from ONVIF devices
• Motion search on recorded footage
• Show analytics on live footage

ONVIF devices have the following limitations with Control Center:

• Show analytics on recorded footage
• Video lockout is not supported by ONVIF devices

You can configure an ONVIF camera using the ONVIF Configuration Utility provided with
Control Center.

Camera Gateway overview
The IndigoVision Camera Gateway enables third party cameras from a range of
manufacturers to be connected to IndigoVision Control Center. The Camera Gateway
takes video streams from third party cameras using their native protocols and enables
users to view the streams in a Control Center front-end application and record them using
NVRs.

The cameras do not need to support ONVIF in order to connect to the IndigoVision system,
giving customers a wide choice of cameras to choose from.

The Camera Gateway supports video streams from H.264, MPEG-4 and MJPEG cameras,
PTZ control, and events.

The Camera Gateway is a software service that can be installed on a Windows server,
giving total flexibility. The Camera Gateway service enables multiple clients to stream
video from the same camera, whilst only requiring a single stream from the camera to the
Camera Gateway.

Video footage authentication overview
To ensure video footage authentication, IndigoVision's Control Center adds security
information to the footage. This security authentication can be checked to ensure the video
footage has not been tampered with and can be used for evidential purposes.

Where supported, video footage on an NVR has a digital signature added to recordings.
This provides the initial source authenticity.

Control Center adds a watermark to the incident when footage is exported for use with
Incident Player. This provides the initial incident authenticity.

Both the initial source and incident authenticity can be verified in Incident Player.

2 Concepts overview Control Center
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An incident can be exported from Incident Player. The exported incident maintains
authenticity of the source and the exported footage.

After exporting from Incident Player, the source authenticity now refers to the video footage
exported from Control Center and the incident authenticity now refers to the exported
incident from Incident Player.

FrontLine System Overview
The IndigoVision FrontLine System allows recording of evidential quality video and audio
using body worn cameras.

• Lightweight, easy-to-use cameras designed from the ground up to support lone
workers

• Automatic import of video and audio from docked FrontLine Cameras into the
Control Center suite.

• Digital signatures and tamper protection of recordings.
• Play back and export of recordings.

The system comprises the following components:

• License Server: An IndigoVision License Server with a Control Center license that
includes the Body Worn Video feature.

• FrontLine Manager: Software used for managing FrontLine Cameras and
automatically importing video.

• FrontLine Dock: Hardware device connected to the PC that is running FrontLine
Manager (the FrontLine Manager PC).
The FrontLine Dock provides ports for docking multiple FrontLine Cameras.

• FrontLine Cameras: Portable cameras that connect to the FrontLine Manager PC
using the FrontLine Dock.

• NVR-AS: An IndigoVision Network Video Recorder/Alarm Server (NVR-AS) that is
used to store and manage recordings downloaded from the FrontLine Cameras.
The NVR-AS must be installed on the FrontLine Manager PC.

• Control Center front-end application: The IndigoVision Control Center front-end
application provides a powerful and flexible user interface for viewing and exporting
the video and audio recordings created by FrontLine Cameras.

• Camera wearer: The person who uses a FrontLine Camera and may or may not be
able to review their recordings in Control Center, depending on their access
permissions.

Figure 1: FrontLine Manager overview

Control Center 2 Concepts overview
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Using body worn video
Users with FrontLine Cameras (camera wearers) can record video and audio footage.

To do this, they are assigned a FrontLine Camera, which they remove from the FrontLine
Dock attached to the FrontLine Manager PC.

They use the camera to record video and audio and then return the camera to the same
FrontLine Dock and FrontLine Manager PC.

The recordings are automatically downloaded from the camera and the camera battery is
recharged.

After the footage has been downloaded the camera can be reused by the same camera
wearer or manually assigned to another user. This cycle is repeated every time a FrontLine
Camera is used.

Automatic NVR switching
Enable automatic NVR switching to allow Control Center to automatically switch to a
different NVR when playing back or exporting footage from a camera. The switch between
NVRs occurs if there is no footage available at the current time on the current NVR and
another NVR in the site has footage from the same camera.

You can specify one or more failover NVRs for an NVR or set up recording jobs on multiple
NVRs to help ensure that footage is available even if the primary NVR fails to record
footage from the camera.

Motion search and replay is available as normal across all alternative NVRs.

Licensing Overview
To operate the Control Center suite, you must have a Control Center license. A Control
Center license covers the number of cameras, encoders and NVR-AS that can be used and
the level of software functionality allowed.

The Control Center license is stored on a License Server and contains the following
information:

• Software tier
This defines the level of software functionality and the maximum number of device
connection licenses allowed.

• Number of device connections
This defines the number of cameras or encoders which can be connected to the
Control Center.
When a camera or encoder is connected to Control Center, you can do the following:
• View live video
• Play back video
• Trigger alarms
• Record video on an unlimited number of NVR-AS servers
You can change the NVR-AS server on which video from a camera or encoder is
recorded without needing the license to be altered.

• Number of third party Windows NVR-AS connections

2 Concepts overview Control Center
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This defines the number of Windows servers which can run the IndigoVision NVR-
AS software.
A third party Windows NVR-AS connection license allows a single Windows server
to run an instance of IndigoVision NVR-AS software.
• An NVR-AS running on a third party server without a third party Windows NVR-

AS connection license cannot record video from a camera or encoder or manage
alarms.

• IndigoVision NVR-AS 3000 and NVR-AS 4000 appliances do not require any
additional license.

Workstations running the Control Center front-end application and servers running NVR-
AS must be connected to the License Server to operate.

The Control Center front-end application and NVR-AS maintain a 30-day rolling backup of
their license.

• If connectivity to the License Server is lost, for example due to routine maintenance,
then this backup is automatically used, and the Control Center front-end application
and NVR-AS continue to operate for 30 days.

• Once connectivity to the License Server is restored, the Control Center front-end
application and NVR-AS revert to using the License Server.

Control Center 2 Concepts overview
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3 CONTROL CENTER INTERFACE

Control Center has three "views" which give you access to different functionality: Live view,
Playback view and Setup view. The first two are available to all users; Setup view is only
available when logged in as an administrator.

Live view

Playback view

Setup view

The Live view main window can display up to 25 video panes for viewing live video. You
can select from a range of video display options.

If you are using multiple PC screens, you can view up to 25 video panes in each window
(with a maximum of 100 live video streams over the PC screens).

If working with recorded video, you can view up to 25 recordings in one window, and live
video in the other windows (up to a maximum of 100 video streams).

You can change the user interface appearance to a dark theme. This is useful if you need
to operate Control Center in low-light conditions, for example, a control room.

Only users who have logged in as operators, can change the user interface appearance.
This feature is not available if you have logged in as an administrator.

Customizing your layout
The user interface can be configured to suit your needs. The interface is made up from
fixed and flexible areas. The fixed areas always appear in the same location in the user
interface. The flexible areas, or panels, can be docked or pinned anywhere within the user
interface.

Docking is the ability to 'snap' a panel into any position around the user interface. As you
move a panel, docking indicators appear on the user interface and placing the panel over
one of these indicators lets you 'dock' the panel in that location.

Using the pinning icon you can automatically hide a panel. After selecting the pin icon in the
title bar of a panel, then moving the mouse away from that panel, the panel automatically
'slides' to the edge of the user interface and becomes a tab option.
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Moving your mouse over the panel tab; the panel 'slides' back into view. It remains there as
long as you have your mouse over the panel or you have pinned the panel again.

• Pinned - The panel is locked and does not hide when you move your mouse
away from the panel.

• Unpinned - The panel auto hides when you move your mouse away from the
panel.

Panels can be:

• Undocked - 'Pulled' from its current location and floated over the top of the user
interface

• Docked - 'Snapped' to a location within the user interface
• Auto hide - Automatically 'hide' the panel when the mouse is moved away to another

part of the user interface
• Open and closed - Panels can be completely removed from the user interface

Control Center remembers your panel layout when you close or log out of the application.
To set all the dockable panels back to the default layout, select View > Reset Panels.

Docking and pinning icons
When you move a panel around the user interface docking indicators appear. After you
have docked a panel you can then auto hide it using the pinning icon.

The following table explains how your panel will be docked when a panel is positioned over
a particular indicator.

Docking indicator Dock or pin description

Dock as a tabbed panel within the existing panel. If this icon is missing then the panel
can not be docked as a tabbed panel.

Dock as a separate panel above the existing panel.

Dock as a separate panel below the existing panel.

3 Control Center Interface Control Center
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Docking indicator Dock or pin description

Dock as a separate panel to the left of the existing panel.

Dock as a separate panel to the right of the existing panel.

Dock the panel across the whole user interface. All the other areas are repositioned
around the docked panel.

Select the pin icon to auto hide the panel.

Panel auto hide is enabled.

Undock a panel
A panel can be undocked from the user interface and then docked in another location or left
floating.

To undock a panel:

1. Click and hold on the title bar of the panel.
Alternatively, you can click and hold a panel tab.

2. Move the panel in any direction.
The docking indicators appear over the user interface.

3. Position the panel in your desired location.
Do not position the panel over a docking indicator or the panel re-docks in the
highlighted area.

4. Release the mouse.
The panel 'floats' and appears above any of the fixed areas of user interface.

The panel can be positioned and resized anywhere on your monitor(s).

Alternatively, right-click the title bar of the panel and select Floating. The panel then floats
over the user interface.

Dock a panel
You can dock a panel anywhere around the user interface.

To dock a panel:

1. Click and hold on the title bar of the panel.
2. Move the panel in any direction.

The docking indicators appear on the user interface.

Control Center 3 Control Center Interface
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Figure 2: Docking indicators

3. While still holding down your mouse, position the panel over one of the docking
indicators.
An area is highlighted showing the potential docked location.

Figure 3: Highlighted docking area

4. If you require a different location, continue holding down the mouse and move the
panel to another docking indicator.

5. Release the mouse.
6. The panel docks in the highlighted position.

3 Control Center Interface Control Center
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The user interface automatically adjusts around the docked panel.

Alternatively, right-click the title bar of the panel and select Docking. The panel then docks
back its last docked location.

Auto hide panels
Using the pinning icon you can automatically hide a panel whenever you move your move
away from the panel.

To auto hide a panel:

1. Select .

The panel automatically 'slides' to the edge of the user interface.
2. Position you mouse over the panel tab and the panel 'slides' back into view. The

pinning icon now indicates that the auto hide option is enabled .
3. Select the pin icon again to lock the panel in position.

Alternatively, right-click the title bar of the panel and select Auto hide. The panel then
slides to the edge of the user interface.

Close and open a panel
Panels can be closed if they are not required after you have configured your layout

To close a panel:

1. Select .

2. Alternatively, select View > [panel name].
3. Disable the selected menu option.

To open a panel:

1. Select View > [panel name].
2. Enable the selected menu option.

Explorer panels
In Control Center, the cameras and zones you are required to monitor are organized into
sites. The Explorer panels display your home site and its contents.

The Explorer panels comprise the following:

Video explorer: displays the all the video objects in the site such as cameras and monitors
Alarms explorer: displays the objects in the site such as alarm servers, detectors, and external data sources
Users explorer: provides access to the users and groups in the site

Video explorer
The Video explorer displays the video objects available in the site.

The following objects are represented.

Site Camera sequence

Control Center 3 Control Center Interface
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Camera Salvo

PTZ camera Guard tour

Camera wearer PA group

NVR Custom objects

Monitor Speaker

Video wall Web pages

Unlicensed camera Camera view

Unlicensed PTZ camera Unlicensed camera view

Video walls, NVRs, and Web pages are only visible in the Setup view.

Alarms explorer
The Alarms explorer displays the alarm objects available in the site.

The following objects are represented.

Site Zone Double knock
detector

Alarm server Basic or
Advanced
analytics detector

NVR fault
detector

Alarm panel Digital Input or
External detector

Video fault
detector

Alarm group Schedule Network fault
detector

Custom object Filter License Server
fault detector

External data
source

Unhandled alarm
detector

CyberVigilant in
Camera detector

Alarm servers, alarm panels, alarm groups, filters, schedules and external data sources
are only visible in the Setup view.
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Users explorer

This functionality is only available if you have administrator permissions.

The Users explorer provides access to the users and groups available in the site.

The following objects are represented.

Groups

Users

Upgrade Recording Jobs for Edge Retrieval

This functionality is only available if you have administrator permissions.

How do I access this menu?

As Administrator, in Setup view, right-click an NVR in the Video explorer, and select
Update Recording Jobs for Edge Storage Retrieval.

NVR-AS supports Edge Storage Retrieval from compatible cameras using Profile G.

► For more information, refer to the NVR-AS 4000 Appliance User Guide.

Recording jobs created using Control Center 17.1 or earlier will need to be updated before
they will work with Edge Storage Retrieval. This menu option will update all recording jobs
on the selected NVR with the required additional information. This must be done for each
NVR that is desired to use the Edge Storage Retrieval functionality.

Update Recording Jobs for Edge Storage Retrieval will not interrupt any recording jobs in
progress.

Events panels
The Events panels, located below the Control Center main window, display current active
alarms, activations, alerts, and bookmarks.

You can move the Events panels individually if required.

Control Center may have been configured to enable you to view video footage from
cameras related to an alarm or a bookmark. Drag-and-drop the alarm or bookmark from the
list into a playback video pane to play back footage starting from the time of the alarm or
bookmark.

Control Center 3 Control Center Interface
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Maps overview
Maps can be used in Live, Playback and Setup views, and provide a representation of the
layout your site(s). Maps enable you to identify the location of the site objects including:

• Where cameras are located, and their field of vision
• Where events have occurred
• Where devices are locate that you need to activate (for example, relays)

There are a number of actions that you can initiate from maps, including:

• Display video from cameras
• Move to other maps
• Deal with alarms
• Actuate relays

Sites may have one or more maps associated with them in Control Center.

Alarm status bar

A. New alarms
B. Acknowledged

alarms

C. Number of alerts
D. Total number of alarms

• The Alarm status bar displays:
• Total number of new and acknowledged alarms, and the number available in the

current filter, if a filter is selected.
• Total number of alert messages currently in the Alerts panel.

• While there are new alerts, and new or unacknowledged alarms, the icon flashes,
and an audible notification sounds (if configured).

• If there are no alerts or unacknowledged alarms, the Alarm status bar indicates that
there are no new alarms or alerts.

• Double-click the Alerts section to open the Alerts panel.
• Double-click the Alarms icon to open the Alarms panel.
• If you have selected a filter then the Alarm status bar updates the list of the total

alarms and the number of alarms in active filter (see example below).

A. New alarms D. Number of alarms in active filter
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B. Acknowledged
alarms

C. Number of alerts

E. Total number of alarms

Monitors panel
The Monitors panel enables you to display live or recorded video on analog monitors and
VCRs in your sites.

Analog monitor with no video playing.

Analog monitor with live video playing.

Analog monitor, which is part of a persistent connection, but does not have a
camera associated.

Analog monitor, which is part of a persistent connection, playing video from the
camera to which it is connected.

Analog monitor which can no longer be contacted by Control Center.

Analog monitor playing back a recording.

VCR with no video playing.

VCR with video playing. 

VCR, which is part of a persistent connection, but does not have a camera
associated.

VCR, which is part of a persistent connection, playing video from the camera to
which it is connected.

VCR which can no longer be contacted by Control Center.

Control Center 3 Control Center Interface
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Alerts panel
The Alerts panel provides access to the Alerts. This panel displays warning and error
messages as they are generated. For example, if a Control Center can't contact a device.
The number of active alert messages is displayed in the Alarm status bar.

Click Clear to remove the alert messages from the Alerts panel. You can't recover the
messages once they have been cleared.

Storyboard panel
The Storyboard panel is used to collect a series of video footage clips which can then be
exported as a single incident.

Clips are selected and added to the Storyboard panel from the timeline. The clips can then
be edited, deleted, reordered or previewed.

To manually edit the start and finish times for a clip, right-click the clip name and select
Edit.

When you have the desired series of clips, an incident can be exported and, if required,
used as evidence.

Storyboard toolbar
Display the layout options for the main window

Create new storyboard

Open saved storyboard

Save the current storyboard

Edit the selected clip

To manually edit start and finish times for the clip, right-click the clip name and
select Edit.
Accept the edits made to the clip

Reject the edits made to the clip

Change the order of the clips by moving the clip up.

Change the order of the clips by moving the clip down.

Clear selected clip from the storyboard

Clear all clips from the storyboard

Preview selected clip. The preview loops continuously until it is stopped using the
controls on the video preview pane.

Preview all clips in the storyboard. The clips are played in the same order they
appear in the storyboard.

Export the clips as a single incident

3 Control Center Interface Control Center
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PTZ Control panel
If you have closed the PTZ Control panel, select PTZ Controls from the View menu to re-
open it. It should look something like this.

This panel enables you to:

• Go to preset positions.
• Perform other actions specific to that camera.
• Refocus a camera.
• Adjust the iris on a camera.
• Work with camera menus.
• Hold all PTZ cameras in their current position and prevent other users from

controlling them.

• The button takes you directly to the help file.

The controls on the PTZ Control panel are enabled when a video pane displaying a camera
is selected. They are disabled if a camera is not selected.

To pan, tilt and zoom a PTZ camera, you use the PC pane itself.

You can also control cameras using a CCTV keyboard.

Drag-and-drop items
Throughout the Control Center interface, you can display video of any kind by dragging and
dropping.

This means that you move the mouse over the required item, click and hold the left mouse
button down and drag the item to the video pane, where you release it.

This method is used in Live view, to display video from a selected camera in a video pane
or on an analog monitor, and in Playback view, to view recorded footage on the timeline, or
to play back video.

Control Center 3 Control Center Interface
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You can also drag video that is being displayed in one video pane and drop it into another
video pane within the same screen.

3 Control Center Interface Control Center
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4 HOW DO I...?

Change password
As an operator, you can't change your password in Control Center. Contact your
administrator and request a new password.

Keep me logged in
When the Keep me logged in option is enabled it means that Control Center keeps your
session active when the application is closed. The next time you start Control Center, you
will not be prompted to enter your credentials.

To completely log out of the application, select File > Log Out.

After logging into your session, it remains active for 30 days without re-logging into Control
Center. Each time you start a Control Center session, the session is extended for 30 days
from the point you started.

If it is more than 30 days since you last logged in, the session expires and you will need to
re-enter your credentials. It is possible to change the default 30 days for the active session.

► For more information on how to adjust the default active session time, refer to the "Site
Database Server Administrator Guide".

When Control Center is closed, your log in credentials are not stored on the system.

Log out
To log out of Control Center and log in as another user without closing Control Center,
select Log out from the File menu. Control Center's Login dialog opens, allowing a different
user to log in.

You may be required to reenter your password when you log out.

Specify how video is displayed

Video display options
You can display live and recorded video in a variety of different ways:
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In a full screen, without toolbars

Click in the toolbar. The video panes expand to fill the entire screen, hiding the
Explorer panels, menu and toolbar.

To view the main menu bar while in full screen mode, press the Alt key.

To view video again in the normal window, click , if enabled, or press F11 or Esc on

your keyboard.

In the current window, without toolbars
To expand the video panes to fill the current video window, hiding the Explorer panels and
toolbar, press F12. The current window is not resized.

To view the main menu bar while in video panes only mode, press the Alt key.

To view video again in the normal window, click , if enabled, or press F12 or Esc on

your keyboard.

In a single large pane, with toolbars
Double-click once in the video pane that you want to view at maximum size.

In the toolbar, click . The display contains a single pane containing video from that
camera.

In multiple panes
You can display video in a variety of different ways on one or more video windows. To

access the different layouts, click in the toolbar and select the layout you require.

You can choose a different layout for each video window. You can use up to 4 video
windows to view additional video panes, with up to 25 in each video window (up to a
maximum of 100 panes in total).

In hot spots

Some of the possible layouts feature a hot spot, for example, . These layouts allow
you to display one camera in a larger pane, and several other cameras in smaller panes.

To move video from a small pane into the hot spot, select the pane playing the video you

want and click to move it into the hot spot. Alternatively, you can drag and drop the
video into the hot spot.

In standard or widescreen
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You can set the video panes to either standard or widescreen aspect ratios. This setting
applies to the active window.

To set the aspect ratio, click in the toolbar and select the aspect ratio required.

Standard

Widescreen

Standard, non-HD video streams are displayed in a black pillar box in widescreen panes.
HD video streams are displayed in a black letter box in standard panes.

In all the available space
You can set the video to fill all the available space in a video pane using the stretch to fit
aspect ratio.

To set the aspect ratio to stretch to fit, click in the toolbar and select .

The video image could be distorted if the aspect ratio of the video pane is not the same as
that of the video.

Change the text or icon size
You can change the size of the text and icons displayed in video panes in Live and
Playback view.

Your Operating System may require these changes to be authorized.

To change the text size:

1. From the Tools menu, select Options, and click the Overlay tab.

2. In the Text Size area, enter the required size for text.

3. Select Adjust the size as the video pane's size changes to adjust the text
size as the video pane size changes.

4. Click OK.

To change the icon size:

1. From the Tools menu, select Options, and click the Overlay tab.

2. In the Icon Size area, select the default icon size (normal, medium or large).

Control Center 4 How do I...?
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3. Select Adjust the size as the video pane's size changes to adjust the text
size as the video pane size changes.

4. Click OK.

Change how date and time are displayed in video panes
You can change how the date and time are displayed in video panes in either Live or
Playback view.

To change the date and time settings:

1. From the Tools menu, select Options, and click the Overlay tab.

2. In the Time on Video Panes area, select one of the following options for either
the live or recorded video:

l None: the time is not displayed
l All: the time is displayed in all video panes
l Selected Pane Only: the time is displayed only in the video pane currently selected

3. Select Include Date to also display the date in the video pane.

4. Click OK.

Your Operating System may require this change to be authorized.

Change the appearance of the user interface
You can change the color theme of the user interface. This is useful if you use Control
Center in low-light conditions.

To change the appearance of the user interface:

1. Select Tools > Appearance.
2. From the Appearance dialog, select a theme:

• Light - light background color
• Dark - dark background color

3. To see your color theme change, restart Control Center.

This feature is only available to users who have logged in as operators. It is not available if
you have logged in as an administrator.

View video in a full screen
You can view video from up to 25 cameras in a full PC screen, without toolbars, as follows:

1. In Live view, drag-and-drop the camera from the Video explorer onto the video pane
you want to use.

2. The video appears in the selected video pane. Repeat step 2 for each camera you
want to display.
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3. Click in the toolbar. The video panes expand to fill the entire screen, hiding

the Explorer panels, menu and toolbar.
4. To view the main menu bar while in full screen mode, press the Alt key.
5. To view video again in the normal window, click , if enabled, or press F11 or

Esc on your keyboard.

Start up in fullscreen mode
To automatically start Control Center in fullscreen mode:

1. Start Control Center and enter fullscreen mode for each video window.

2. Exit Control Center (Alt+F4) without leaving fullscreen mode.

3. Restart Control Center. Each video window displays in a full screen.

Keep Control Center on top
You can specify that Control Center should always be displayed on top of other
applications.

From the Tools menu, select Options. In the General tab, select Keep Control Center
window always on top. Click OK.

Your Operating System may require this change to be authorized.

View live video

Reveal a hidden zone
When viewing live or recorded video, you may find that certain areas of the scene have
been blocked out, usually for reasons of privacy.

If you are authorized, you can reveal these areas to view the whole scene.

1. Select the pane containing the hidden areas.
• If you are viewing live video, select Reveal Hidden Zone from the Live Video

menu.
• If you are viewing recorded video, select Reveal Hidden Zone from the Playback

menu.
The hidden zone is removed to reveal the entire scene.

2. To hide the zone again, select Reveal Hidden Zone again.

View live video from a camera on the PC screen
To view live video using the Control Center interface:

Control Center 4 How do I...?
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1. In Live view, select the camera in the Video explorer whose video you want to
view.

2. Drag the camera name onto one of the PC panes in the main window and
release the mouse button.

Live video is displayed in the video pane using the configured video and audio profile
for the camera.
If dynamic video profile switching is configured, then the appropriate High Resolution
or Low Resolution profile is automatically chosen based on the camera resolution
and the size of the video pane.

Dynamic profile switching is only supported for panomorph cameras for users who have
the Switch live video profile on video pane count setting enabled.

To view live video using a CCTV keyboard:

1. On the keyboard, enter the number allocated to the video pane where you
want to view the video. This selects the video pane where the video will be
displayed.

2. Enter the number of the camera you want to view. The video is displayed in
the selected video pane.

The LED on the keyboard displays only the number of the video pane you have selected,
not the camera number.

View live video on an analog monitor

You can only view live video on an analog monitor from IndigoVision cameras and
transmitters.

To view live video using the Control Center interface:

1. In the Monitors Pane, locate the icon that represents the monitor where you
want to view video.

2. In the Video explorer, select the camera whose video you want to view.

3. Drag the camera onto the icon representing the monitor and release the
mouse button.

Live video is displayed on the monitor. Details of the camera and the date and time
may also be displayed.

To view live video using a CCTV keyboard:

1. On the keyboard, enter the number allocated to the monitor where you want to
view the video. This selects the monitor where the video will be displayed.

2. Enter the number of the camera you want to view. The video is displayed in
the selected monitor.

In the event of a video lockout, video display is stopped on all analog monitors:
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l If the monitor is compatible with this version of Control Center, it goes blank but the connection
persists, and the icon in the Monitors Pane remains green. When video lockout stops, the cam-
era is displayed again on the monitor.

l If the monitor is incompatible with this version of Control Center, it goes blank and the icon in the
Monitors Pane turns blue. When video lockout stops, the camera display does not restart and the
monitor remains blank.

The LED on the keyboard displays only the number of the video pane you have selected,
not the camera number.

View live video on an IndigoVision video wall
To view live video on an IndigoVision video wall, you can either use Control Center or a
CCTV keyboard.

To push live video to an IndigoVision video wall using Control Center:

1. In Live view, select a live video window.

2. Select in the main toolbar menu.
3. Select the IndigoVision Video Wall to push video to.

The list only displays Video Walls which have at least one workstation configured.
4. Select the workstation to use.

To push live video to an IndigoVision video wall using a CCTV keyboard:

1. On the keyboard, enter the number allocated to the video pane where you want to
view the video.

2. Enter the number of the camera you want to view. The video is displayed in the video
pane entered in step one.

The LED on the keyboard displays only the number of the video pane you have selected,
not the camera number.

To clear video from an IndigoVision video wall:

1. Stop video in all panes on the current video window

2. Select in the main toolbar.

This pushes the empty video window to the video wall.

Video wall content is not automatically synchronized with the Control Center video window.
If you want to update the layout or cameras on the IndigoVision video wall, push the video
window to the video wall again.
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View live video on a Barco video wall
To push live video to a Barco video wall:

1. In Live view, select a live video window.

2. Select in the main toolbar.
3. Select the Barco Video Wall to push video to.

The list only displays Video Walls which have at least one perspective configured.
4. Select the perspective to use.

Control Center updates the Barco video wall to show the layout in that video window, and
display live video from the cameras currently showing in that layout.

To clear video from a Barco video wall:

1. Stop video in all panes on the current video window

2. Select in the main toolbar.

This pushes the empty video window to the video wall.

Video wall content is not automatically synchronized with the Control Center video window.
If you want to update the layout or cameras on the Barco video wall, push the video window
to the video wall again.

Work with live video

Stop displaying live video

To stop displaying live video in a single video pane, use one of the following options:

Click in the video pane displaying the video you want to stop.
Right-click in the video pane and select Stop.

To stop video playing in all PC panes:

Click in the toolbar.
If you are using more than one video window, only video playing in the window in which you clicked is
stopped.

You cannot use a CCTV keyboard to stop video playing in all video panes. However, if you
stop a sequence or a guard tour using the keyboard, all cameras or salvos contained in it
are stopped.

To stop displaying live video on an analog monitor, use one of the following options:

Right-click the analog monitor in the Monitors Pane and select Stop.
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Record live video

You can record live video playing in a video pane at any point. Recordings made in this way
are known as "on-demand recordings".

To start recording live video:

• Right-click the video pane you want to record, select Record from the drop-down
menu, then select to record with or without audio.

• Alternatively, click the arrow beside in the video pane toolbar to display a drop-
down list. From the drop-down list, select to record with audio or to record without
audio.

To stop recording live video:

• Right-click in the video pane, select Record from the drop-down menu, then select
Stop Recording.

• Alternatively, press in the video pane toolbar.

Pressing does not stop any scheduled recordings.

A recording icon (with audio , without audio ) is displayed in the video pane when that
camera is being recorded. Video may be recorded if a recording has been scheduled, or
someone else has started to record it, as well as when you start recording manually.

To play back these recordings, use the Playback view, where they will appear on the
timeline.

You can also take a snapshot of a particular moment while watching live video.

Zoom in and out of live video

You can zoom into specific areas of live video to a magnification of up to 800%.

1. Click in the video pane to activate the zoom.

2. Click the area of the video pane you want to see in more detail. The
magnification is displayed in the lower left corner of the video pane.

3. Right-click the video pane to zoom out again.

4. Click again to deactivate the zoom.

While the zoom is activated, click and drag the mouse across the pane to view different
parts of an image when it is magnified. The cursor changes to a hand.

Save a snapshot of a video frame

When viewing video, you may want to take a snapshot image of a particular frame playing
in the video pane. The name of the camera, the site, and a time date & stamp are captured
in the snapshot.

To take a snapshot using the default settings, select the video pane displaying the video, and click
in the toolbar and select Save Snapshot (or press F4).
To take a snapshot and define your own settings, select the video pane displaying the video, and click

in the toolbar and select Save Snapshot As...
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While the snapshot is being taken, a camera icon appears in the top right of the video pane.

Snapshots can be saved as either a bitmap (.bmp) or JPEG (.jpeg) file. The default
filename contains the name of the camera and the time the snapshot was taken.
Snapshots are saved to the snapshot folder on your PC.

Administrators can define the default format and snapshot folder on the Options - General
tab.

Save a snapshot from all video panes

When viewing video, you may want to take snapshot images of video playing in all panes.
You can also take a snapshot of video playing in a single video pane.

To take a snapshot of all panes playing video, click in the toolbar and select
Snapshot All. While the snapshots are being taken, a camera icon appears in the top right
of the video panes.

Snapshots are saved to the snapshot folder on your PC. The filename contains the name of
the camera and the time the snapshot was taken. Snapshots are saved as either a bitmap
(.bmp) or JPEG (.jpeg) file.

Administrators define the file format and snapshot folder on the Options - General tab.

Print snapshot of live video

When viewing video, you may want to print a live video snapshot. Control Center can send
an image of a snapshot directly to a printer.

To print a snapshot of live video, select the pane playing the video, and click in the
toolbar and select Print Snapshot... Select the required printer from the Print dialog and
click OK. The camera name, site name, IP address, and time of the snapshot footage are
printed below the image.

The snapshot image is not saved to your PC. To save a snapshot, click in the
toolbar and select Save Snapshot As...

Specify snapshot settings

This functionality is only available if you have administrator permissions.

You can define the default folder and file format for snapshots.

To define the default snapshot settings:

1. Select Options from the Tools menu.
2. Click Browse in the Snapshot area, and navigate to the folder where you want to

save snapshots.

4 How do I...? Control Center



Control Center Operator's Guide - v18.1 41

3. Select the Snapshot format.
4. If you want to allow users to change these settings on the Save Snapshot As dialog,

select Allow users to change snapshot folder and format.
5. Click OK.

Your Operating System may require this change to be authorized.

Show an overlay

When viewing live or recorded video, you can show an image on top of the video stream.
This is useful when you need to provide context for the scene or to show beam positions.

If you are authorized, to show the overlay image:

1. Select a video pane.
2. Right-click in the video pane and select Show Custom Camera Overlay.

If you are authorized, to hide the overlay image:

1. Select a video pane.
2. Right-click in the video pane.

If an image is displayed, the Show Custom Camera Overlay option is ticked.
3. Select Show Custom Camera Overlay to hide the overlay image.

Administrators define the image to be used for the overlay.

Control a PTZ camera

Some cameras may have PTZ (Pan- Tilt- Zoom) functionality. You can control these
cameras using the Control Center interface or a CCTV keyboard.

Display video from the required PTZ camera in the video pane you want to use.

If you are using the Control Center interface to control the camera, click in the video pane to display a PTZ
control “grid” over the video. This grid indicates that you have successfully connected to the camera, and
provides pan, tilt and zooming functionality.
If you are using a CCTV keyboard, move the joystick to display a PTZ control “grid” over the video. This grid
indicates that you have successfully connected to the camera, and provides pan, tilt and zooming func-
tionality.

If you are using the Control Center interface to control the PTZ camera, you can use the
PTZ Control Panel to access more functionality. To view the Control Panel, select View >
PTZ Controls.
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Interact with someone I see on screen

There may be occasions when you need to interact with people you view on screen.
Control Center provides audio functionality to enable you to speak and listen to people you
view in a particular location.

You can listen to more than one video pane at once. If you are using multiple windows, you
can listen to audio from all windows. However, you can only speak through your
microphone to one camera at a time.

In Live view:

To speak to someone you view on camera, right-click in the video pane and select Speak. Alternatively, click
in the pane displaying video from the camera.

To listen to someone you view on camera, right-click in the video pane and select Listen. Alternatively, click

in the pane displaying video from the camera.

Carry out an action at any time

Control Center may have been configured so that you can perform certain actions, such as
opening a door, at any time, and not just when an alarm occurs. These actions are known
as relays.

To perform an action while viewing video from a particular camera
1. In Live view, display video from the required camera in a video pane.

2. Click the arrow beside to display a list of available actions.

A maximum of 4 relays are displayed per camera.

3. Select the required action from the drop-down list to perform it.

Depending on how the relay has been configured, Control Center may require a second,
authorized user to enter their password before the relay is activated.
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To perform an action from a map
1. In Live view, display the map with the required relay.

2. Click the arrow beside to display a list of available actions.
3. Select the required action from the drop-down list to perform it.

Depending on how the relay has been configured, Control Center may require a second,
authorized user to enter their password before the relay is activated.

To perform an action at any time
1. From the Live Video menu, select Actions.

2. Select All actions.
3. Choose the required action from the list and click Activate.

Depending on how the relay has been configured, Control Center may require a second,
authorized user to enter their password before the relay is activated.

Replay live video I've just viewed

Control Center enables you to replay recently viewed video footage displayed in Live view
(provided that this video has been recorded).

You can replay the last 10, 15, or 30 seconds of footage, or replay from the time of the
previous alarm from a single camera, or all cameras currently playing in the active window.
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When replaying all cameras from an alarm time, the alarm time is taken from the currently
selected pane in the active window. If there is no alarm time available, this option is not
enabled.

If a sequence or a guard tour is running in the selected video pane, the footage replayed is
from the camera that was active when Replay was selected, rather than replaying the
sequence or guard tour.

To replay live video from a single camera:

1. In Live view, select the pane containing the camera for which you want to view the
recorded footage.

2. Click Replay in the toolbar and select the option you require.
Depending on the configuration, Control Center either:
• switches to Playback view and replays the video footage selected, or
• remains in Live view and replays the video footage in the selected video pane.
If there is no recording for this period, the application informs you of this.

To replay live video from all cameras in the active window:

1. In Live view, select a pane in the window containing the cameras for which you want
to view the recorded footage.

2. Click Replay in the toolbar and select the Replay all option you require.
• Control Center switches to Playback view and replays the video footage.
If there is no recording for this period, the application informs you of this.

View stream statistics

To view details of frame rate, resolution, and video/audio bit rates for a live video stream,
select Show Stream Statistics from the Live Video menu.

Statistics are shown for all cameras which are currently displaying video on screen.

Show event count on screen

Control Center can count the number of events that have occurred in live video from a
camera since video was started. To show this count in a PC pane:

1. In Live view, display the camera you require in a video pane.
2. From the Live Video menu, select Show Event Count.

An overlay appears in the bottom left of the pane, and shows the number of events
as they occur.

Reset the event count

Control Center can count the number of events that have occurred in live video from a
camera since video was started. To reset the count showing in a video pane, from the Live
Video menu, select Reset Event Count. The event count is reset to zero.

Locate a camera

When you are viewing live video from a camera, you may want to know where the camera
is located in the Video explorer, or on a site map.

To locate a camera:
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1. In the Live view, right-click the video pane displaying video from the camera you
want to locate.

2. Select Locate Camera. The camera is highlighted in the Video explorer, and, if the
camera has been added to a site map, on the map.

Work with salvos

Salvo overview

Salvos provide a convenient way of displaying a collection of frequently viewed cameras.
Each salvo contains a particular set of cameras, specified by the administrator, which can
be displayed quickly using the video windows or analog monitors. For example, there may
be cameras which are frequently displayed at the same time. Using a salvo enables you to
display them with a single action.

A salvo may have a video pane layout associated with it. This means that each time the
salvo is displayed, the video panes change to the specified layout.

Salvo icon

Salvo with specified layout

Starting a salvo

Salvos can be started manually using the Control Center interface or a CCTV keyboard.
Control Center may have been configured to automatically display a salvo of cameras that need to be mon-
itored at regular, timed intervals.
Control Center may also have been configured to automatically start up a salvo when you log in.

Displaying a salvo

A salvo may have a video pane layout associated with it. This means that when that salvo is displayed, the
video panes change to that layout.
When you start a salvo with a layout manually, it always starts in the first pane of the selected video window.
Salvos wrap in all available panes to display as many cameras as possible.

For example:
l Salvo A contains 8 cameras.
l Salvo A does not have a layout associated with it.
l The current video layout has 9 panes.
If you start Salvo A in pane 8, the first two cameras in the salvo are displayed in
panes 8 and 9, camera 3 is displayed in pane 1, camera 4 in pane 2 and so on.

A salvo may be part of a guard tour. The guard tour settings may override whether or not a salvo changes the
layout of the video panes.
A salvo can be associated with an alarm group. Control Center displays the salvo when alarms associated
with the alarm group are triggered.

View a salvo on a PC screen

You can display salvos in a PC screen or on an analog monitor using the Control Center
interface or using a CCTV keyboard.
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View a salvo in a video window using the Control Center interface:

1. In Live view, drag-and-drop the salvo you require from the Video explorer onto a
video pane in the main window.

If a salvo has a layout, it is shown as . If it does not, it is shown as .

Salvos with a layout always start in the first pane of the window in which they are displayed.

2. The combination of cameras appears as specified in the salvo.

View a salvo on an analog monitor

You can display salvos on analog monitors or on the PC screen using the Control Center
interface or using a CCTV keyboard.

Salvos provide a quick display of frequently-viewed cameras.

To view a salvo on an analog monitor using the Control Center interface:

1. In Live view, drag-and-drop the salvo you require from the Video explorer onto the
analog monitor where you want to view the first camera in the salvo.

If a salvo has a layout, it is shown as . If it does not, it is shown as .
2. The combination of cameras appears on the analog monitors in the salvo.

Work with sequences

Sequence overview

Sequences enable you to view video from each camera in succession in a video pane or on

an analog monitor. They are displayed as in the Video explorer.

Starting a sequence

Sequences can be started manually using the interface or a CCTV keyboard.
Control Center may have been configured to automatically display a sequence that needs to be monitored at
regular, timed intervals.
Control Center may also have been configured to automatically start up a sequence when you log in.

Run a sequence on the PC screen

You can run sequences on the PC screen or on an analog monitor using the Control Center
interface or using a CCTV keyboard.

To run a sequence on the PC screen using Control Center:

1. In Live view, drag-and-drop the camera sequence from the Video explorer on
to the video pane where you want to run it.

Each camera is displayed in succession in the video pane.
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2. Use the video pane control buttons to control the sequence:

l To step back one camera, click .
l To step forward one camera, click .
l To hold a sequence, click . Click again to resume the sequence. If you have a PTZ camera
in a sequence, you must hold the sequence in order to control its movements.

Run a sequence on an analog monitor

Sequences enable you to view video from each camera in succession on an analog
monitor or in a video pane.

To run a sequence on an analog monitor using Control Center:

1. Drag the required sequence from the Video explorer onto the icon
representing the analog monitor where you want to run the sequence in the
Monitors Pane.

2. Release the mouse over the analog monitor icon. Each camera is displayed in
succession on the analog monitor.

l To step back one camera, select Previous in Sequence from the Live Video menu.
l To step forward one camera, select Next in Sequence from the Live Video menu.
l To hold a sequence, select Hold Sequence from the Live Video menu. Select Resume
Sequence to resume the sequence.

Work with guard tours

Guard Tour overview

A guard tour is a sequence of salvos. They are displayed as in the Video explorer.
In this example, the Airport guard tour is made up of three salvos: Terminal 1, Terminal 2,
and Terminal 3.

When the guard tour is displayed in a video pane or on an analog monitor, salvo 1 is
displayed first for a specified length of time. Salvo 2 is then displayed, followed by salvo 3.
When salvo 3 has been displayed for the set time, salvo 1 is displayed again.

Starting a guard tour

You can start a guard tour manually at any time using the control Center interface or a CCTV keyboard.
Control Center may have been configured to automatically display a guard tour of cameras that need to be
monitored at regular, timed intervals.
Control Center may also have been configured to automatically start up a guard tour when you log in.

Displaying guard tours

When a guard tour which is set to change layout runs, it always starts in the first pane of the selected video
window.
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Guard tours do not "wrap".
For example:
l Terminal 1 guard tour contains 4 salvos, each of which contains 4 cameras.
l The guard tour layout is fixed and does not change per salvo.
l The current video layout has 9 panes.
If you start running the guard tour in pane 8, the first two cameras in the first salvo
are displayed in panes 8 and 9. Cameras 3 and 4 are not displayed. When the
second, third, and fourth salvos are displayed, the first two cameras are shown, but
not cameras 3 and 4.

If you change the layout to show more panes, the "missing" guard tour panes are
displayed.

You can display one guard tour at a time on your analog monitors. For example, if you have eight analog
monitors, you can only display one guard tour at a time on them. If the guard tour needs less than eight mon-
itors, the others can be used to display separate cameras, salvos and sequences, as usual.
You can display one guard tour at a time in a video window. If you are using multiple windows, you can dis-
play one tour in each of the windows.
If you are displaying a camera in a video pane or an analog monitor, and you start a guard tour in that pane
or analog monitor, the guard tour takes precedence over the individual display and video from that camera is
stopped.
If a guard tour is running, and you start video from a single camera in one of the panes, the video from the
single camera takes precedence and the guard tour is stopped.

Run a guard tour on the PC screen

You can run guard tours on the PC screen or on an analog monitor using the Control
Center interface or using a CCTV keyboard.

To run a guard tour on the PC screen using Control Center:

1. In Live view, drag-and-drop the guard tour icon you want to run from
the Video explorer onto a video pane.

l If the guard tour has been set to change layout according to the layout of the salvo it is currently
displaying, it automatically starts in the first pane of the selected video window.

l If the guard tour has not been set to change layout, you can start the guard tour in any pane.

2. The combination of salvos runs as specified in the guard tour.

3. To stop the tour, select Stop Guard Tour from the Live View menu.

When a guard tour is in progress, Control Center displays the salvo and tour name at the
bottom of the screen.

Run a guard tour on an analog monitor

You can run guard tours on analog monitors or on the PC screen using the Control Center
interface or using a CCTV keyboard.

A guard tour is a sequence of salvos. When a guard tour is displayed in a video pane or on
an analog monitor, each salvo is displayed for a specified length of time.
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To run a guard tour on an analog monitor using Control Center:

1. In Live view, drag-and-drop the guard tour you require from the Video
explorer onto the analog monitor where you want to view the first salvo.

2. The combination of salvos appears on the analog monitors in the guard tour.
3. To stop the tour, select Stop Guard Tour from the Live View menu.

Work with persistent connections

Persistent connections overview

A persistent connection is a connection between a camera and an analog monitor/VCR. It
is known as persistent because it remains in place:

If Control Center is closed down.
If the connection to any of the devices is lost and subsequently recovered, for example, when a device power
cycles.

An administrator must specify the analog monitor/VCR for the persistent connection, but
operators can specify or change the camera that forms part of the connection.

Specify a camera for a persistent connection

1. In Live view, drag-and-drop the camera you want to be part of the connection
from the Video explorer to the monitor or VCR.

The analog monitor or VCR which has been specified for the link is displayed with a
padlock in the Monitors Pane:

or

2. You have now established a persistent connection between this camera and
analog monitor/VCR, which will continue even when Control Center is closed
down, or the connection to any of the devices is lost, then comes back again.
When you restart Control Center, the connection will still exist as you have
specified.

Change the camera in a persistent connection

Persistent connections can be set up between a camera and an analog monitor/VCR. To
change the camera in a connection:

1. In Live view, right-click the analog monitor/VCR in the Monitors Pane and stop
the video that is playing from the camera. This breaks the connection but
leaves the analog monitor/VCR available for another camera.

2. Drag the required camera from the Video explorer and drop it over the analog monitor/VCR to create
a new persistent connection.

Alternatively, you can simply drag-and-drop the new camera onto the analog monitor. This
breaks the connection with the original camera and creates a persistent connection
between the new camera and the analog monitor/VCR.
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View recordings

Play back a recording in a video pane
You can play back up to 25 recordings on your PC screen in different layouts. You can
choose to play the recordings independently, or to play them back from the same time.
Video footage is indicated by a blue line in the timeline, and audio by a green line.

To play back a single recording on the PC screen:

1. Make sure you are in Playback view.

2. In the Video explorer, locate the camera from which you want to play back
recorded footage and drag and drop it onto a video pane. Choose a time to
play back from by doing one of the following:

l To go to the first recording from that camera, click .
l To go to the end of the most recent recording from that camera, click .
l To select a precise time to start playing back a recording, select Set Time Range > Custom from
the Timeline menu and enter a time.
The time shown for a recording in Recorded Video view is determined by the local time of the
site to which the camera belongs, not by the PC on which it is being viewed. The timezone is
shown in the status bar below the application e.g. (GMT -5:00) Eastern Time US and Canada.

l Double-click the timeline at the point from which you want to start playing back video.

3. Press . The recorded footage is played back from the specified time, and
continues until you stop it.

If video is already playing, Control Center starts playing automatically from the time you
have selected. If there is no footage at the selected time, the recording starts playing back
from the next available section of footage, if available.

4. Audio is automatically enabled when you start displaying a camera in a video

pane. To turn audio off, click in the bottom right of the pane.

Change the playback NVR
If a gap occurs in the recorded video you are watching, you can change the playback NVR.
This allows you to view video from the same camera, recorded onto a different NVR.

The site administrator will have set the failover NVRs for the site. See Set up a failover
NVR for full details.

To change the playback NVR:

4 How do I...? Control Center



Control Center Operator's Guide - v18.1 51

1. Ensure you are in the Playback view.

2. In the Cameras panel, on the left of the screen, right-click on the camera you
wish to view.

3. Select Change Playback NVR from the menu. The Change Playback NVR
dialog opens.

4. Do one of the following:

l Select Use failover NVR and, select the failover NVR that you wish to use from the drop-down
menu.

l Select Use other NVR and, select the NVR that you wish to use from the drop-down menu.

5. Click OK. Now you can browse the available recordings as normal. See View
recordings for full details.

To change back to the primary NVR, follow the same steps as shown above but at step 4
select Use primary NVR and click OK.

Play back a recording on an analog monitor
1. Make sure you are in Playback view.

2. In the Video explorer, select the camera that you want to view a recording
from. Drag-and-drop it into a video pane. This allows you to find the footage
that you want to view on the analog monitor. Choose a time to play back from
by doing one of the following:

l To go to the first recording on that camera, click .
l To go to the end of the most recent recording on that camera, click .
l To select a precise time to start playing back a recording, select Set Time Range > Custom from
the Timeline menu and enter a time.
The time shown for a recording in Recorded Video view is determined by the local
time of the site to which the camera belongs, not by the PC on which it is being
viewed. The timezone is shown in the status bar below the application, for
example, (GMT -5:00) Eastern Time US and Canada.

If you know the exact time that you want to play back from on the analog monitor, simply
click the timeline at that point - you do not need to first view the video in a video pane.

3. Drag the required camera from the Video explorer onto the analog monitor in
the Monitors Pane where you want to view the recording. The recording starts
playing back in the selected analog monitor from the time you selected.

If video is already playing, Control Center starts playing automatically from the time you
have selected. If there is no footage available for the selected time, a message is displayed
indicating that no footage is available.
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Play back several recordings at once

Overview of multiple playback

Control Center enables you to play back up to 25 recordings at once.

You can choose to play back each recording independently, and to navigate through each
of them separately.

Alternatively, you can synchronize the recordings, so that they all play back from the same
time. When you use the video controls in synchronized mode, the action applies to all
recordings that you are playing back.

Play back recordings independently

You can play back up to 25 recordings independently, and navigate through each of them
separately, as follows:

1. Make sure you are in Playback view.

2. Drag-and-drop the cameras you want to play back from into the video panes.

3. For each camera, select the time you want to play back from, and use the
video control buttons above the timeline to view the video.

Synchronize recordings

When you enter synchronized mode, all cameras play back from the same time, and all
video controls you use apply to all cameras.

1. Make sure you are in Playback view.
2. Drag-and-drop the cameras you want to play back from into the video panes.
3. Select one of the cameras and go to the time you want to start playing back video

from.
4. Click beside the video control buttons on the timeline. An orange box appears

around all the video panes, and the time in all panes changes to the time you
selected.
Any video controls you now use (for example, play, fast-forward, pause, or the video
controls in each pane) apply to all cameras.

5. To play back recordings independently , click again.

Work with recordings

Playback functionality

You can control the playback of the recording using the playback control buttons and the
speed/jog shuttle that appear below the video panes. These controls have similar
functionality to that of an analog video recorder.

Zoom in on a recording — Click to activate the zoom, then click the part of the footage you
want to see in more detail. The magnification is shown in the left hand corner of the pane.
Zoom out of a recording — Click to activate the zoom, then right-click the video footage to
zoom out of a particular area.

Scroll round image — To view different parts of an image when it is magnified,click the hand,
then right-click and drag the mouse across the pane.
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Export Mode — Click to enable Export Mode. In export mode you can define the start and end
time of the recorded footage you want to export. Drag the yellow markers on the timeline to
define the start and end times.
Add To Storyboard - Click to add the selected recorded footage to the Storyboard panel.

Add Bookmark — Click to add a new bookmark to the timeline. You must enter a comment
into the text box then click the OK button to add the bookmark.

Synchronize video — Click to synchronize the time in all video panes. An orange box appears
around all the video panes to indicate that Control Center is in synchronized mode. Any
video controls you now use (for example, play, fast-forward, pause, or the video controls in
each pane) apply to all cameras.
Audio in selected pane only — Click to turn on audio in the selected pane, and off in all other
panes.

Audio in all panes — Click to turn on audio in all video panes.

Rewind — Click once to play backwards at x2 normal speed, again for x8 and then for each

subsequent click; x16, x32, x64, and x128. Click to return to normal speed. When
playing back at 8 or 16 times normal speed, key frames are played, not every frame. At all
other speeds, every frame is played.
Frame back — Step back one frame at a time.

Play — Click to start playing video.

Pause — Click to pause video at a particular point in the recording. Click again to start the
video again.

Frame forward — Step forward one frame at a time.

Fast forward — Click once to play forwards at x2 normal speed, again for x8 and then for

each subsequent click; x16, x32, x64, and x128. Click to return to normal speed.
When playing forward at 16 times normal speed, key frames are played, not every frame. At
all other speeds, every frame is played.

You can play back the recording at various speeds using the speed/jog shuttle.

Timeline overview

Use the timeline:

Determine when video and audio footage is available between set times for a particular camera.
Display a graph indicating when motion or audio was detected during a recording.
Indicate where alarms have occurred.

A. Current time marker
B. Recorded audio
C. No footage available

D. Recorded video
E. Current threshold

You can show or hide the timeline and playback controls by selecting Show Playback
Controls in the Playback view menu.
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Move the time marker

The current time marker marks the current point in the recorded footage. It is shown as a
vertical blue line on the timeline.

To move the time marker to an approximate point in the recorded footage, point and click
the mouse on the timeline.

Expand and contract the timeline

You can expand and contract the timeline, allowing you to view it in more or less detail.

To view a shorter period of the timeline in more detail, click to the left of the timeline.
To view a longer period of the timeline in less detail, click to the left of the timeline.

Stop playback

To stop playing a recording on the PC screen

Click in the playback pane.

To stop playing a recording on an analog monitor
1. In the Monitors Pane, right-click the required analog monitor.

2. Select Stop. The recording playback is stopped.

Save a snapshot of a video frame

When viewing video, you may want to take a snapshot image of a particular frame playing
in the video pane. The name of the camera, the site, and a time date & stamp are captured
in the snapshot.

To take a snapshot using the default settings, select the video pane displaying the video, and click
in the toolbar and select Save Snapshot (or press F4).
To take a snapshot and define your own settings, select the video pane displaying the video, and click

in the toolbar and select Save Snapshot As...

While the snapshot is being taken, a camera icon appears in the top right of the video pane.

Snapshots can be saved as either a bitmap (.bmp) or JPEG (.jpeg) file. The default
filename contains the name of the camera and the time the snapshot was taken.
Snapshots are saved to the snapshot folder on your PC.

Administrators can define the default format and snapshot folder on the Options - General
tab.

Save a snapshot from all video panes

When viewing video, you may want to take snapshot images of video playing in all panes.
You can also take a snapshot of video playing in a single video pane.
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To take a snapshot of all panes playing video, click in the toolbar and select
Snapshot All. While the snapshots are being taken, a camera icon appears in the top right
of the video panes.

Snapshots are saved to the snapshot folder on your PC. The filename contains the name of
the camera and the time the snapshot was taken. Snapshots are saved as either a bitmap
(.bmp) or JPEG (.jpeg) file.

Administrators define the file format and snapshot folder on the Options - General tab.

Print snapshot of recorded video

Control Center allows you to send an image of a snapshot from recorded video directly to a
printer.

To print a snapshot of recorded video, select the pane playing the video, and click
in the toolbar and select Print Snapshot.... Select the required printer from the Print dialog
and click OK. The camera name, site name, IP address and time of the snapshot footage
are printed below the image.

The snapshot image is not saved to your PC. To save a snapshot, click in the
toolbar and select Save Snapshot As...

To print a snapshot of zoomed footage, click in the timeline to select the zoom in tool.

Click the part of the footage you want to see in more detail. Click in the toolbar and
select Print Snapshot... to print the original snapshot with the zoomed section beside it.
The level of magnification is indicated along with the camera name, site name, IP address
and time of the snapshot footage.

Pause/resume playback

To pause a recording on the PC screen
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1. Click below the playback window. The recording playback is paused at the
current frame.

2. To resume playback, click .

To pause a recording on an analog monitor
1. Select an analog monitor in the Monitors Pane.
2. From the Playback menu, select Pause.
3. To resume playback, select Unpause from the Playback menu.

Go to the start of recordings

To go to the start of the first recording made from a camera:

1. Make sure you are in Playback view.

2. In the Video explorer, locate the camera from which you want to play back
recorded footage and drag-and-drop it into a video pane.

3. Click . This takes you to the start of the first recording made from that
camera. Alternatively, you can press the Home key on your keyboard.

Go to the end of recordings

To go to the end of the last recording made on a camera:

1. Make sure you are in Playback view.

2. In the Video explorer, locate the camera from which you want to play back
recorded footage and drag-and-drop into a video pane.

3. Click . This takes you to the end of the last recording made on that camera.
Alternatively, you can press the End key on your keyboard.

Rewind a recording

To rewind a recording on the PC screen, click below the playback window to rewind
the recording. The video plays backward at a faster speed. When rewinding at 8 times or
higher than normal speed, only key frames are played. At all other speeds, every frame is
played.

Click again to stop rewinding and to play back at normal speed.

To rewind at different speeds, use the speed/jog shuttle.

You cannot rewind recordings playing on analog monitors.

Fast-forward a recording

To fast-forward a recording on the PC screen, click below the playback window. The
current time marker moves forward and the video plays forwards at a faster speed. When
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playing back at 16 times or higher than normal speed, only key frames are played. At all
other speeds, every frame is played.

Audio is only played up to 8 times normal speed.

Click again to stop playing faster and to play back at normal speed.

To fast-forward at different speeds, use the speed/jog shuttle.

You cannot fast-forward recordings playing on analog monitors.

Start Edge Storage Search

Edge Storage Retrieval will start automatically when a camera is reconnected after a
network interruption or NVR start. If it is necessary to trigger manually, this can be done.

Control Center 17.2 or later must be used along with Windows NVR-AS 17.2 or later to
enable support of Edge Storage Retrieval. See the NVR User Guide for more information
enabling and configuring on this functionality.

To change the playback NVR:

1. Ensure you are in Playback view.

2. Select Start Edge Storage Search from the Playback menu.

Edge Storage Retrieval starts checking for missing recordings on all
connected NVRs.

NVR Footage Retrieval

1

This functionality is only available if you have administrator permissions.

NVR-AS supports footage retrieval from an IndigoVision NVR that is configured as part of
the same site.

NVR Footage Retrieval permits the automatic transfer of recordings from the source NVR
to a destination NVR. Footage Retrieval is intended for instances when a smaller NVR is
outside of network coverage during operation, for example, when on a vehicle; when the
source NVR reconnects to the network, the footage is retrieved.

To enable NVR Footage Retrieval, Control Center 18.0 or later and Windows NVR-AS 18.0
or later must be used.
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1

NVR Footage Retrieval is not intended to be a replacement for NVR redundancy. For more
information on failover functionality, click here.

To set up NVR Footage Retrieval:

1. In Setup view, select the desired destination NVR from the Video Explorer.
2. On the right-hand panel select the Footage Retrieval tab.
3. Click Add Source NVR.
4. Select the source NVR, and click OK.

When a NVR is no longer required to be a source NVR, click Remove Source NVR.
1

It is not necessary for source NVRs to be online when they are added on the Footage
Retrieval tab.

1

Before adding a source NVR, the NVR must be added to a site in Control Center.

When a NVR is selected from the Video Explorer, it is possible to view the other NVRs in
the site that use the NVR as a source NVR, and if necessary, remove that NVR as a
destination.

1

When setting up the Control Center site hierarchy, it is recommended the source NVR is in
the same site, or a sub-site, of the destination NVR.

Destination NVRs are only displayed on the Footage Retrieval tab when the destination
NVR:

• Has been added to a site in Control Center.
• Is online and contactable.

Step backwards through a recording

Click to step backwards through the footage frame by frame. When you reach a gap
in the footage, it jumps backwards to the end of the previous footage.

You cannot step backwards through a recording playing on an analog monitor .

Step forwards through a recording

Click to step forward through the footage frame by frame. When you reach a gap in
the footage, it jumps forwards to the start of the next footage.
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You cannot step forward through a recording playing on an analog monitor.

Work with audio in a recording

When you start viewing a recording in a video pane, audio is automatically enabled. This is

indicated by at the bottom right of the pane.

To turn audio off, click in the bottom right of the pane. Click to enable it
again.

Alternatively, click in the timeline to enable audio in the selected pane and disable it in all
other panes. Click in the timeline to enable audio in all panes currently displaying video.

View video for an event

You can configure Control Center to associate video to a detector. You can review the
recorded video for the event, at any time.

To view video for a particular event:

1. In the Playback view, select the Activations panel.

If the Activations panel is not displayed, select Events > Activations from the View
menu or double-click the Alarm status bar.

2. Click to display the Find Activations dialog.

3. Specify which site you want Control Center to search in. This determines
which detectors appear in the Available list. Select a detector and click

to move it to the Selected list. To select all detectors in the site, click
.

4. If required, specify the activation details.

5. Choose the required time period using the hour, day, week or month options,
or enter a custom time period.

6. Click OK to display the Activations in the Activations panel.

7. Select the activation from the list, then drag-and-drop it into a video pane.

Work with thumbnails

Thumbnails overview

Control Center enables you to display thumbnails of still images taken from recorded video.
You can then browse these, choose an image and start playback from the time of the
image.

There are four different thumbnail views. Only one of these views is visible at any one time:

Time-based thumbnail view: This displays a fixed number of images, distributed at equal intervals across
the current range of the timeline. Click Time-based Thumbnails to access this view.
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Alarm thumbnail view: This displays an image for each alarm that is in the current timeline range. Click
Alarm Thumbnails to access this view.
Bookmark thumbnail view: This displays an image for each bookmark that is in the current timeline range.
Click Bookmark Thumbnails to access this view.
Activation thumbnail view: This displays an image for each activation that is in the current timeline
range. Click Activation Thumbnails to access this view
Search thumbnail view: This displays an image from each time that the motion or audio profile in the cur-
rent timeline range exceeds the threshold. Click Search Thumbnails to access this view.

To view the playback window again without playing from the time of the thumbnail, click No
Thumbnails. To return to the previous thumbnail view, click Previous Thumbnails.

The thumbnail views display images within the current range of the timeline. When the
range of the timeline is changed by expanding, contracting, scrolling or changing the
current time, the thumbnail views are updated to show only the images within the time
range.

The events displayed on the timeline are the ones listed in the Events panels. By default
the Events panels show all events since midnight of the previous day. To use the Search to
change the events listed, click .

To browse the thumbnails in the time range shown on the timeline and other time periods:

• Move around the timeline using the expand/contract timeline, scroll left/right controls
and timeline controls to display thumbnails in different time periods. This may result
in fewer or more thumbnails being displayed.

• Use the scroll bar on the right of the thumbnail view to browse all the thumbnails for
the current time range.

View time-based thumbnails of recorded video

To view time-based thumbnails of the recorded video currently in the time range:

1. Click Time-based Thumbnails on the toolbar.

2. The thumbnails for the time range currently visible on the timeline are
displayed. The current time range is divided into 36 equal intervals and the
thumbnail view contains an image corresponding to the time in the middle of
each interval. Double-click a thumbnail to start playing back video from that
point.
The time shown for a recording in Recorded Video view is determined by the
local time of the site to which the camera belongs, not by the PC on which it is
being viewed. The timezone is shown in the status bar below the application
e.g. (GMT -5:00) Eastern Time US and Canada.

3. To return to the playback window, click No Thumbnails.

View thumbnails of alarms

You can display thumbnails which display a still image from each time an alarm has
occurred. Each thumbnail contains the date and time that the image was recorded, and the
name of the zone the alarm occurred in.

To display the alarm thumbnails:

1. Click Alarm Thumbnails on the toolbar.
2. The alarm thumbnails for the current time range are displayed, including the time

and zone of the alarm. Double-click a thumbnail to start playing back video from that
point. To filter alarm thumbnails click in the header bar.
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View thumbnails of all activity over threshold

To view time thumbnails of the recorded video currently in the time range, click Search
Thumbnails on the toolbar. The thumbnails for the current time range are displayed.

Any points of significant motion or audio found during a search are displayed on the
timeline as peaks above the set threshold value. To view thumbnails of the recorded video
which exceeds the threshold value, select Motion Search or Audio Search from the
Search menu.

The thumbnail view contains an image for each time that the motion or audio profile
exceeds the threshold. Double-click a thumbnail to start playing back video from that point.

View thumbnails of bookmarks

You can display thumbnails which display a still image from each time a bookmark has
been added. Each thumbnail contains the date and time that the image was recorded.

You can only view bookmarks that you are authorized to view.

To display the bookmark thumbnails:

1. Click Bookmark Thumbnails on the toolbar.
2. The bookmark thumbnails for the current time range are displayed. Double-click a

thumbnail to start playing back video from that point.

View thumbnails of activations

You can display thumbnails which display a still image from each time an activation has
occurred. Each thumbnail contains the date and time that the image was recorded, and the
name of the detector which caused the activation.

To display the activation thumbnails:

1. Click Activation Thumbnails on the toolbar.
2. The activation thumbnails for the current time range are displayed, including the time

and detector for each activation. Double-click a thumbnail to start playing back video
from that point. To filter activation thumbnails click in the header bar.
For more information about filtering thumbnails, click here.

Review recordings

Find a specific recording

To search for recordings in the Playback view timeline:

1. Click the Playback view button on the toolbar.

The first time you display footage from any camera, Control Center displays
recorded footage from the previous hour in the timeline. If you are later searching for
video footage from a different camera, Control Center uses the times you specified
for the last camera.

2. If you want to view footage from a different time, select Set Time
Range>Custom... from the Timeline menu.
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3. Enter the times between which you want to view recordings.
The time shown for a recording in Playback Video view is determined by the
local time of the site to which the camera belongs, not by the PC on which it is
being viewed. The timezone is shown in the status bar below the application
e.g. (GMT -5:00) Eastern Time US and Canada.

4. In the Video explorer, select the camera that you want to view a recording
from. Drag-and-drop it onto a video pane.

5. Click to start playing back the recording. You can control the playback of the
recording using the playback control buttons.

Zoom in and out of recordings

To zoom in on a recording while it is playing or paused, click to select the zoom in tool.
Click the part of the footage you want to see in more detail. The magnification is shown in
the left hand corner of the pane. You can magnify the image up to 800%.

While is selected, right-click the video pane to zoom out again. Alternatively, you can
click to select the zoom out tool and click the video pane to zoom out again.

To view different parts of an image when it is magnified, click and drag the mouse across
the pane when zooming in or zooming out. The cursor changes to a hand. Alternatively,
click and drag the mouse across the pane.

View recorded video associated with an alarm

Control Center may automatically display a looped replay from a camera or salvo in a new
video pane when an alarm occurs. The looped replay is displayed next to the live video

from the same camera. The looped replay icon is displayed in the video pane.

If Automatic NVR switching is enabled, there may be a brief pause during playback while
Control Center searches for an alternative NVR to play back footage from.

You can also manually display recorded video from an associated camera or a salvo where
an alarm has occurred.

To manually view recorded video associated with an alarm:

1. Ensure you are in Playback view.

2. Select the required alarm in the Alarms panel.

If the Alarms panel is not displayed, select Events > Alarms from the View menu or
double-click the Alarm status bar.

3. Drag-and-drop the alarm from the list into the playback window. This plays
back footage from the camera associated with the alarm starting from the time
of the alarm.

For video of the alarm to be displayed, the camera must be associated with a zone.
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Show analytics in playback

This functionality is not supported for panomorph cameras.

You can specify that Control Center displays analytics in playback. The items displayed
vary depending on the camera model and analytics configuration but are one or more of the
following:

• a rectangle around each object detected by the camera
• small squares to show recent motion (motion trace)

The rectangle and squares are normally green, but change to red if that object
triggers an event.

To show analytics in playback:

1. In Playback view, drag-and-drop the camera you require into a video pane.

2. Click in the video pane, or select Show Analytics in the context menu, to
show analytics rules and any motion that occurs in that pane.

This feature requires that the camera is configured to send analytics information.

Reveal a hidden zone

When viewing live or recorded video, you may find that certain areas of the scene have
been blocked out, usually for reasons of privacy.

If you are authorized, you can reveal these areas to view the whole scene.

1. Select the pane containing the hidden areas.
• If you are viewing live video, select Reveal Hidden Zone from the Live Video

menu.
• If you are viewing recorded video, select Reveal Hidden Zone from the Playback

menu.
The hidden zone is removed to reveal the entire scene.

2. To hide the zone again, select Reveal Hidden Zone again.

Show an overlay

When viewing live or recorded video, you can show an image on top of the video stream.
This is useful when you need to provide context for the scene or to show beam positions.

If you are authorized, to show the overlay image:

1. Select a video pane.
2. Right-click in the video pane and select Show Custom Camera Overlay.

If you are authorized, to hide the overlay image:

1. Select a video pane.
2. Right-click in the video pane.

If an image is displayed, the Show Custom Camera Overlay option is ticked.
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3. Select Show Custom Camera Overlay to hide the overlay image.

Administrators define the image to be used for the overlay.

View video for an event

You can configure Control Center to associate video to a detector. You can review the
recorded video for the event, at any time.

To view video for a particular event:

1. In the Playback view, select the Activations panel.

If the Activations panel is not displayed, select Events > Activations from the View
menu or double-click the Alarm status bar.

2. Click to display the Find Activations dialog.

3. Specify which site you want Control Center to search in. This determines
which detectors appear in the Available list. Select a detector and click

to move it to the Selected list. To select all detectors in the site, click
.

4. If required, specify the activation details.

5. Choose the required time period using the hour, day, week or month options,
or enter a custom time period.

6. Click OK to display the Activations in the Activations panel.

7. Select the activation from the list, then drag-and-drop it into a video pane.

Save and protect recordings

Save recordings as evidence

You can save (export) up to 31 days of recorded footage at a time. Each hour is saved as a
separate file. Files are labeled 1 of 3, 2 of 3 etc.

If you have several cameras which have recorded footage of a particular event, you can
save these as an incident, making the review process much easier.

You can also ensure that the recordings are not deleted automatically by the NVR on which
they are stored.

If automatic NVR switching is enabled, Control Center exports video from alternative NVRs
when there is a gap in recordings on the primary NVR, in the same way as when Control
Center plays back video.

You can choose to:

• Export recordings from a single camera to another location
• Export recordings from multiple cameras to another location
• Protect a recording from deletion without exporting it

Save a recording from a single camera

You can save up to 31 days of recorded footage at a time. Each hour is saved as a
separate file. Files are labeled 1 of 3, 2 of 3 etc.
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Date and time information for footage from ONVIF and third party cameras is not available
in the exported footage.

You can save any recording to a disk, onto a CD or onto a network drive, from where you
can play it back. When you save the recording, a copy is made to the location selected. The
recording is still accessible via the Control Center.

If you are saving recordings to a CD, the behavior depends on the CD writing software
available on the PC, and on the operating system. You can save the file directly to the CD,
but the CD writing software may intervene and prompt you to copy the file to CD as an extra
step.

To save a recording from a single camera:

1. In the Setup view, select a camera or NVR from the Video explorer and click the
Recordings tab.

2. Right-click a recording and select Export and Protect... The Export and Protect
Recording dialog opens.

Recorded footage is not listed on the Recordings tab when the site is in offline mode. To
export recordings, set the site back online.

3. Select the start (From) and finish (To) time of the footage you wish to export.
4. If necessary, select the Protect check box to ensure the original footage on the NVR

is not deleted.
5. Enter a name for the Incident.
6. Select the Location where you want to save the recordings.
7. If there is a hidden zone in this video pane, select Allow incident reviewer to reveal

hidden zone to allow the hidden zone to be revealed.

If this option is unavailable, you may not have permissions to reveal hidden zones.

8. If you would like to export the bookmarks associated with the recording, select
Include Bookmarks.
Only bookmarks you are authorized to view are exported.

Bookmarks cannot be exported when the site is in offline mode. To export bookmarks, set
the site back online.

9. Select Copy Incident Player, if required, to save a copy of the Incident Player
application.

10.Select Write date and time on exported recordings, if required, to add the date and
time to the recording.

11.Select Rename new recordings to prevent the system from overwriting existing
recordings with the same file name.
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The system uses the camera name and recording start time for the recording file name.

12.Click OK. The progress of the export process is shown.

When saving the recoding has finished, it indicates the length of recording that has been
saved. This may be shorter than the time you requested. There are several possible
reasons for this.

Additional steps are required when saving a recording to a CD

13.In My Computer, double-click the CD recording drive. Windows displays the
temporary area where the file is held before being copied to the CD.

14.Verify that the recording you intend to copy to the CD appears under Files Ready to
be Written to the CD.

15.Right-click in the main window and select Write these files to CD. Windows displays
the CDWriting Wizard. Follow the instructions in the wizard.

Save a recording from multiple cameras

You can save up to 31 days of recorded footage at a time. Each hour is saved as a
separate file. Files are labeled 1 of 3, 2 of 3 etc.

Date and time information for footage from ONVIF and third party cameras is not available
in the exported footage.

If you have several cameras which have recorded footage of a particular event, you can
save these as an incident, making the review process much easier. You can also ensure
that the recordings are not deleted automatically by the NVR on which they are stored.

Recorded footage cannot be protected when the site is in offline mode. To protect the
footage, set the site back online.

You can save any recording to a disk, onto a CD or onto a network drive, from where you
can play it back. When you save the recording, a copy is made to the location selected. The
recording is still accessible via the Control Center.

If you are saving recordings to a CD, the behavior depends on the CD writing software
available on the PC, and on the operating system. You can save the file directly to the CD,
but the CD writing software may intervene and prompt you to copy the file to CD as an extra
step.

To save a recording from multiple cameras:

1. In the Playback view, click in the timeline, then drag the yellow markers on the
timeline to select the start and end times of the recorded footage you want to export.

2. Right-click a camera or site and select Export and Protect... The Export and Protect
Recordings dialog opens.
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The cameras currently playing in the active video window are selected by default. If
you wish to include additional cameras, select the check boxes corresponding to the
cameras you wish to include.
If you have many cameras in your site, select Show only selected cameras to see
only the ones already selected.

3. Select the Protect check box, if necessary, to ensure the original footage on the
NVR is not deleted.

4. Enter a name for the incident.
5. Select the Location where you want to save the recordings.
6. If there is a hidden zone in this video pane, select Allow incident reviewer to reveal

hidden zone to allow the hidden zone to be revealed.

If this option is unavailable, you may not have permissions to reveal hidden zones.

7. If you would like to export the bookmarks associated with the recording, select
Include Bookmarks.
Only bookmarks you are authorized to view are exported.

Bookmarks cannot be exported when the site is in offline mode. To export bookmarks, set
the site back online.

8. Select Copy Incident Player, if required, to save a copy of the Incident Player
application.

9. Select Write date and time on exported recordings, if required, to add the date and
time to the recording.

10.Select Rename new recordings to prevent the system from overwriting existing
recordings with the same file name.

The system uses the camera name and recording start time for the recording file name.

11.Click OK. The dialog closes and the Export Status dialog opens.

When saving the recording has finished, it indicates the length of recording that has been
saved. This may be shorter than the time you requested. There are several possible
reasons for this.

Additional steps are required when saving a recording to a CD

12.In My Computer, double-click the CD recording drive. Windows displays the
temporary area where the file is held before being copied to the CD.

13.Verify that the recording you intend to copy to the CD appears under Files Ready to
be Written to the CD.

14.Right-click in the main window and select Write these files to CD. Windows displays
the CDWriting Wizard. Follow the instructions in the wizard.
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Save recordings using a storyboard

Footage added to the Storyboard panel can be edited to create a single incident that uses
footage from multiple cameras.

To save a recording using the Storyboard panel:

1. From the View menu, select Storyboard. The Storyboard panel opens.
2. After selecting a video pane, in the timeline select .
3. Drag the yellow markers to the desired start and end times.
4. Select to add the selected footage to the storyboard panel.

The selected footage is added to the Storyboard panel. The Storyboard panel
displays the camera name, and start and end times of the footage.

5. Select to edit a selected clip in the storyboard.

6. Select or to reorder clips in the storyboard panel.

7. Select or to preview the storyboard.

8. Select to export the storyboard as an incident.

The Export storyboard dialog opens.
9. Enter a name for the incident.
10.Select the Location where you want to save the recordings.
11.If you would like to export the bookmarks associated with the recording, select

Include Bookmarks.
Only bookmarks you are authorized to view are exported.

Bookmarks cannot be exported when the site is in offline mode. To export bookmarks, set
the site back online.

12.If there is a hidden zone in this video pane, select Allow incident reviewer to reveal
hidden zone to allow the hidden zone to be revealed.

If this option is unavailable, you may not have permissions to reveal hidden zones.

13.Select Copy Incident Player to include the Incident Player application in the same
folder as the exported recording. This lets users review recordings even if they have
not got a copy of the player already installed on their PC.

14.Select the Protect check box, if necessary, to ensure the original footage on the
NVR is not deleted.

15.Select Write date and time on exported recordings, if required, to add the date and
time to the recording.

16.Click OK. The dialog closes and the Export Status dialog opens.

Protect recordings

Use the following procedure if you wish to protect a recording without exporting it.
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Recorded footage cannot be protected when the site is in offline mode. To protect the
footage, set the site back online.

If automatic NVR switching is enabled, Control Center protects video from alternative
NVRs when there is a gap in recordings on the primary current NVR, in the same way as
when Control Center plays back video.

1. In Playback view, use the Playback controls to find the start of the recorded footage
you want to protect.

2. Stop or pause the playback at that point to ensure the current time marker is at the
correct time.

If you already know the times from which you want to protect the recording you do not have
to carry out this step.

3. From the Playback menu, select Protect Only. The Protect Recording dialog opens.
4. Confirm the start time and duration of the recording to be protected, then click OK.

Work with incidents

Save a recording as an incident

When you have several cameras that have recorded footage of a particular event from
different angles, Control Center allows you to save this footage as an incident. This makes
reviewing the footage of the event much easier by allowing you to view all the footage
simultaneously.

An incident is a collection of files contained in an incident directory. These include the ivi
file used to start the incident player, the footage directory which contains all the footage,
and the IncidentDB directory which contains the site database files for the incident.
Footage is exported in MP4 format.

Use the IndigoVision Incident Player to play back footage saved as an incident.

► To save a recoding as an incident, see " Save a recording from multiple cameras" on
page 1

Date and time information for footage from ONVIF and third party cameras is not available
in the exported footage.

Install Incident Player

When you exported footage as an incident, you may have also copied the Incident Player
application. If you did not, a copy is available on the IndigoVision Control Center CD.
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If you are installing Incident Player from a CD, and autorun is enabled on the drive, the
setup program should start immediately. However, you can also install it manually if
autorun is not enabled:

1. Browse to the location of the Incident Player setup.exe file.

2. Double-click the setup.exe file.

3. When the installation process is complete, click Finish.

4. If Control Center locates any incident folders in the same folder as the
setup.exe file, you are prompted to enter the location on the PC where you
want to store the incident video clips. Click Browse to select a location for the
incidents.

5. To open one of the incidents, select it from the list and select Open the
selected incident when done. Once the incidents have been copied, Incident
Player launches automatically and displays the selected incident.

Play back recorded footage from disk or CD

To play back incidents and recordings exported to disk or CD from Control Center, use
IndigoVision's Incident Player or a third party application, such as QuickTime.

You can save a copy of Incident Player at the same time as exporting a recording.

Work with maps

Maps overview
Maps can be used in Live, Playback and Setup views, and provide a representation of the
layout your site(s). Maps enable you to identify the location of the site objects including:

• Where cameras are located, and their field of vision
• Where events have occurred
• Where devices are locate that you need to activate (for example, relays)

There are a number of actions that you can initiate from maps, including:

• Display video from cameras
• Move to other maps
• Deal with alarms
• Actuate relays

Sites may have one or more maps associated with them in Control Center.

Map toolbar
Click to move to the previous map you viewed.

Click to move to a map you viewed before clicking the Back button.

Click to move up a level to the parent site and display the map of the parent site.

Click to move to the main map for the home site.

Display video from the selected object, or all cameras on the map id no object is
selected.
Quick View video from cameras. Select then click a point on the map to start all video
covering that point; or click and drag to start all video from cameras in the selected area
of the map.
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Maps are automatically displayed when an alarm occurs. Click this to turn this feature
off, and click again to turn it back on.
Resizes the map to display the complete map in the window.

Resizes the map to display the default map view in the window.

Click to zoom in.

Click to zoom out.

Display a map
To display a map of a particular site:

1. Select the site you require in the Video explorer.

2. Click in the toolbar.
3. A map of the site opens.

You can zoom in or out using the zoom buttons or mouse scroll-wheel, and click and
drag the map to navigate around it.

View video from a map
While viewing a map, you can start live or recorded video for the following objects:

• Cameras
• Zones with associated video
• Detectors with associated video

To start video from a map, do one of the following:

• Right-click the object and select View
• Double-click the object

In addition, you can double-click a point on the map to start video from all cameras
with a field of vision that covers that point.

• Drag-and-drop the object from the map to a video pane or analog monitor

You can only view live video from IndigoVision cameras and transmitters on an analog
monitor.

• Quick View all cameras covering a location on the map. The field of visions for the
cameras covering the location are highlighted.

For PTZ cameras, you can define the field of vision for the full range of the camera as well
as the presets defined on the camera. When you Quick View the field of vision for the
camera, the field of vision is highlighted with stripes, and video is displayed for the
camera's current position. When you Quick View the field of vision for a preset, the field of
vision is highlighted as normal, and the camera moves to that preset.

• Click in the map toolbar and click a point on the map to start video from all
cameras with a field of vision that cover that point.

• Ctrl + click a point on the map to start video from all cameras with a field of vision
that cover that point.
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• Click in the map toolbar then click and drag to select an area on the map to
start video from all cameras within that area.

• Ctrl + drag to select an area on the map to start video from all cameras with a field
of vision within that area.

• Click in the map toolbar
Starts video from the selected object, or from all cameras if no object is selected.

Deal with alarm from a map
When an alarm on a map occurs, a map of that site may automatically be displayed. You
can then acknowledge or clear the alarm from the map if required.

The zone and detector that caused the alarm flash to indicate what caused the alarm. If an
area has been defined for the zone or detector, that is also displayed.

If you do not want to view the relevant map when an alarm occurs, click in the map pane
toolbar. If you click this button again, the relevant map will again be displayed when an
alarm occurs.

Alternatively, if you are not currently displaying a map, select Show Map from the Alarms
menu.

Search for motion

Show analytics in live video

This functionality is not supported for panomorph cameras.

You can specify that Control Center displays analytics in live video. The items displayed
vary depending on the camera model and analytics configuration but are one or more of the
following:

• blue lines or shapes that represent the analytics rules you configured on the camera,
such as a beam

• a rectangle around each object detected by the camera
• small squares to show recent motion (motion trace)

The rectangle and squares are normally green, but change to red if that object
triggers an event.

To show analytics in playback:

1. In Live view, drag-and-drop the camera you require into a video pane.

2. Click in the video pane, or select Show Analytics in the context menu, to
show analytics rules and any motion that occurs in that pane.

This feature requires that the camera is configured to send analytics information.
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In recorded video

Motion Search overview

Motion search enables you to locate and review sections of recorded footage during which
something of interest may have occurred. This reduces the need to review hours of
recorded footage to search for evidence of an incident.

You can:

Find motion in a section of footage and display the profile of motion.
Display thumbnails of motion over the threshold.
Play back footage from any point where motion is found.

A. Significant motion
B. Threshold

C. Motion under the threshold is
not considered significant

D. No motion analysis available at
this point

Search for motion in recorded video

You can use Control Center to search for periods during which significant motion has
occurred.

Motion search is not available for footage recorded in M-JPEG format.

The position of the threshold on the timeline determines the number of points of significant
motion. You can change the threshold value to view more or less significant motion.

1. Make sure you are in Playback view.

2. Select the camera which recorded the footage you want to see in the Video
explorer, and drag-and-drop it onto a video pane.

3. Use the timeline controls and scroll buttons to locate the section of
footage for the camera.

4. Move the cursor to the position on the timeline from where you want to start
the search.

5. Click to start searching for motion.

Control Center begins to compile a profile on the timeline of all activity over the
specified time. Points of significant motion are marked as peaks in the graph.
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If the motion profile is not displayed, select Show Motion Profile from the Timeline menu.

6. Click or to quickly jump to the next/previous point of significant motion on
the timeline.

You can view the current search results and start playing back video as soon as Control
Center begins to compile the timeline - you do not have to wait until it is complete. You can
also view thumbnails of all motion over the threshold.

Play back video found by search

Any points of significant motion or audio found during a search are displayed on the
timeline as peaks above the set threshold value. To play back video from a particular point,
double-click the timeline at that point. Video at the time of the motion or audio is displayed
in the playback window.

• To jump to the next point in the profile where activity exceeds the threshold, click .
• To jump backwards to the most recent point where activity exceeds the threshold,

click .

If Automatic NVR switching is enabled, there may be a brief pause during playback while
Control Center searches for an alternative NVR to play back footage from.

Change the threshold value

The threshold value sets the level of significant motion or audio. Motion or audio detected
above the threshold is considered "significant". Control Center creates thumbnails at the
times the threshold is exceeded, and allows you to jump between these points. Initially, the
threshold value is set to 50%.

To set an approximate threshold value to be used during the search, make sure you are in Playback view
and drag the arrow on either side of the timeline to the value you require.

To enter an exact threshold value, make sure you are in Playback view, select Change Threshold from the
Search menu and enter the threshold value you require in the dialog box.

Specify motion search options

To specify motion search options for a camera, click above the timeline.

Motion search is not available for footage recorded in M-JPEG format.
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The dialog displays the image taken from the recording at the time of the current time
marker. It is divided into blocks that enable you to specify which areas of the scene are to
be observed or ignored when Control Center searches through the recording for motion.

Initially the whole image is set to detect motion. If a region of interest has been set
previously, the dialog displays the last region set for the camera.

1. Define the area where motion will be detected.
To set a single cell to detect motion, click it with the left mouse button. The square is shown
in full color, and the red border changes to surround the area that is detecting motion.
To set a single square to ignore motion, click it with the right mouse button. The square is
shown in gray, and the red border changes to surround the area that is detecting motion.
To set a larger area to detect or ignore motion, click and drag over a number of cells while
holding the left or right mouse button down. Each cell that the mouse goes over will be set to
detect or ignore motion.
To set the region of interest so that motion is detected over the whole image, click Detect All.
To set the region of interest so that motion is ignored over the whole image, click Ignore All.
Click Show Grid to turn the grid on or off.

2. Select the search mode:

The search modes available depend on the type of camera from which the
footage was recorded.

Normal: This enables you to search for motion in all directions.
Direction: This enables you to specify the direction of motion to search for. Click the arrows
around the video pane to specify the direction. The direction may be one or more of up,
down, left or right.

The motion values in the profile will be higher the more an object is
moving in any of the specified directions. You can combine this option
with the object size.

Museum: This enables the addition or removal of an object from a scene to be detected. A
peak in the motion profile will be generated if the object:

l Appears and remains in the scene
l Is removed from the scene, and not returned.
l You can combine museum mode with the object size.

Sensitivity: Controls how sensitive all blocks are to changes in their background. The range
is 0 to 100 inclusive.
Integration time : Specifies how long an object must have been in the scene or been
removed from the scene before the change is detected.

3. Define object size:
This enables you to specify the minimum and maximum size of moving
objects. Peaks in the motion will only be generated if the moving object is
within the specified size range. Object size can be combined with all other
options.

4. Define the performance:
This enables you to specify the accuracy with which Control Center searches
for motion. The higher the accuracy, the longer the search will take.
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The Performance setting is not available for footage recorded from all cameras, and
when Museummode is selected.

5. When you have specified the motion search options, click OK.

If the region of interest or other search options have changed, a message is displayed
informing you that all previous motion profile data for the camera will be cleared, and
asking if you want to continue.

View thumbnails of all activity over threshold

To view time thumbnails of the recorded video currently in the time range, click Search
Thumbnails on the toolbar. The thumbnails for the current time range are displayed.

Any points of significant motion or audio found during a search are displayed on the
timeline as peaks above the set threshold value. To view thumbnails of the recorded video
which exceeds the threshold value, select Motion Search or Audio Search from the
Search menu.

The thumbnail view contains an image for each time that the motion or audio profile
exceeds the threshold. Double-click a thumbnail to start playing back video from that point.

Show analytics in playback

This functionality is not supported for panomorph cameras.

You can specify that Control Center displays analytics in playback. The items displayed
vary depending on the camera model and analytics configuration but are one or more of the
following:

• a rectangle around each object detected by the camera
• small squares to show recent motion (motion trace)

The rectangle and squares are normally green, but change to red if that object
triggers an event.

To show analytics in playback:

1. In Playback view, drag-and-drop the camera you require into a video pane.

2. Click in the video pane, or select Show Analytics in the context menu, to
show analytics rules and any motion that occurs in that pane.

This feature requires that the camera is configured to send analytics information.
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Search for audio

Audio Search overview
Audio search enables you to locate and review sections of recorded footage during which
something of interest may have occurred. This reduces the need to review hours of
recorded footage to search for evidence of an incident.

You can:

Find audio in a section of footage and display the profile of the audio.
Display thumbnails of video that occurred when the audio is over the threshold.
Play back footage from any point where audio is found.

A. Significant audio
B. Threshold

C. Audio under the threshold is
not considered significant

D. No audio available at this point

Search for audio in recorded video
You can use Control Center to search for periods during which significant audio has been
recorded.

Audio search is only available for recorded footage containing AAC-encoded audio.

The position of the threshold on the timeline determines the number of points of significant
audio. You can change the threshold value to view more or less significant audio.

1. Make sure you are in Playback view.

2. Select the camera which recorded the footage you want to see in the Video
explorer, and drag-and-drop it onto a video pane.

3. Use the timeline controls and scroll buttons to locate the section of
footage for the camera.

4. Move the cursor to the position on the timeline from where you want to start
the search.

5. Click to start searching for audio.

Control Center begins to compile a profile on the timeline of all activity over the
specified time. Points of significant audio are marked as peaks in the graph.
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If the audio profile is not displayed, select Show Audio Profile from the Timeline menu.

6. Click or to quickly jump to the next/previous point of significant audio on
the timeline.

You can view the current search results and start playing back video as soon as Control
Center begins to compile the timeline - you do not have to wait until it is complete. You can
also view thumbnails of all audio over the threshold.

Change the threshold value
The threshold value sets the level of significant motion or audio. Motion or audio detected
above the threshold is considered "significant". Control Center creates thumbnails at the
times the threshold is exceeded, and allows you to jump between these points. Initially, the
threshold value is set to 50%.

To set an approximate threshold value to be used during the search, make sure you are in Playback view
and drag the arrow on either side of the timeline to the value you require.

To enter an exact threshold value, make sure you are in Playback view, select Change Threshold from the
Search menu and enter the threshold value you require in the dialog box.

Play back video found by search
Any points of significant motion or audio found during a search are displayed on the
timeline as peaks above the set threshold value. To play back video from a particular point,
double-click the timeline at that point. Video at the time of the motion or audio is displayed
in the playback window.

• To jump to the next point in the profile where activity exceeds the threshold, click .
• To jump backwards to the most recent point where activity exceeds the threshold,

click .

If Automatic NVR switching is enabled, there may be a brief pause during playback while
Control Center searches for an alternative NVR to play back footage from.

View thumbnails of all activity over threshold
To view time thumbnails of the recorded video currently in the time range, click Search
Thumbnails on the toolbar. The thumbnails for the current time range are displayed.
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Any points of significant motion or audio found during a search are displayed on the
timeline as peaks above the set threshold value. To view thumbnails of the recorded video
which exceeds the threshold value, select Motion Search or Audio Search from the
Search menu.

The thumbnail view contains an image for each time that the motion or audio profile
exceeds the threshold. Double-click a thumbnail to start playing back video from that point.

Work with alarms and relays

Alarms overview
The IndigoVision Control Center can be configured to detect alarms when any of the
following occur:

A trigger device is activated (for example, a pressure-sensitive pad is activated, or a window is broken).
Actions are detected by a camera using video analytics (for example, motion).
External systems are activated.
A fault is detected with a device (for example, network connection is lost).

Detectors are configured in Control Center to activate when events are captured by
devices such as PIRs, pressure-sensitive pads, or cameras. Detectors are grouped into
zones. Zones organize detectors into logical groups, for example, one floor of a building, to
help manage alarms more effectively.

When a detector is activated, it triggers an alarm in the zone. If more than one detector in a
zone is activated before the alarm is cleared, no further alarms are triggered.

Two detectors can be combined as a double knock detector that is activated when both
detectors are triggered. For example, the detector activates when a door opens and motion
is detected.

A schedule can be applied to zones and detectors to specify when they are active and,
therefore, when alarms can be triggered.

An alarm is indicated by a flashing alarm icon in the Alarm status bar and the alarm
appears in red type in the Alarms panel. The detectors that activated the alarm are also
displayed in the Detectors tab. Other methods may also be used to indicate that an alarm
has occurred.

To ensure alarms are responded to in a timely manner, you can configure the system to
escalate alarms. If an alarm has not be responded to within the defined timeout period, the
system escalates it by bringing it to the attention of another group of users.

Events and subsequent detector activations are captured and filtered by an alarm server,
and passed onto Control Center. They are stored on the same alarm server. Alarms can
also originate from other external systems and be filtered by an alarm server.

Escalation policy overview
The IndigoVision Control Center can be configured to escalate alarms to ensure they are
responded to in a timely manner. If an alarm has not be responded to within the defined
period, the system escalates it by bringing it to the attention of another group of users.

The timeout and user groups for each escalation level are specified in an escalation policy.
The escalation policy specifies the following:
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The users who can view an alarm (user groups) at each level
The timeout after which new and acknowledged alarms are escalated to the next level

An escalation policy can specify from two to five escalation levels. After the timeout has
expired, the alarm is escalated to the next level. When an alarm is escalated, it also
becomes visible to all users in the user group assigned to the next escalation level.

Within the escalation policy, different timeouts can be defined for each alarm priority
ensuring priority alarms are escalated appropriately.

You can define an escalation policy for each alarm server in your site. The escalation policy
applies to all alarms triggered on that alarm server.

Handling alarms
New alarms are displayed in bold, red type in the Alarms panel. Control Center can indicate
that an alarm has occurred in a number of methods. Select an alarm in the Alarms panel to
view the activations that caused the alarm.

When an alarm occurs, you can acknowledge it to show other users that you are aware of
the alarm and are dealing with it. Enter a note in the Acknowledge Alarms dialog to capture
any relevant information about the alarm.

After you have taken the necessary action to deal with the alarm, you can clear the alarm.
You may need to enter a note in the Clear Alarm dialog to explain the actions you took to
resolve the alarm.

Take action when an alarm occurs

How do I know an alarm has occurred?

The alarm appears in red type and the alarm icon flashes in the Alarm status bar. It is initially unac-
knowledged.
The Video explorer icon for the zone in which the alarm occurred changes to reflect the zone's status.
The alarm sound is activated (if this has been configured). You may hear either a single sound or a con-
tinuous alarm, depending on how this has been set up.
A map of the site where the alarm has occurred may be displayed. The zone or detector on the map will
flash, and the associated area is highlighted if defined.
Live video from the camera or salvo associated with the alarm is automatically displayed in an alarm group
window, if configured. The alarm overlay in the video pane is colored red, or bolded depending on the cam-
era, to indicate that it has been displayed in response to an alarm. Alarms generated from Unusual Motion or
Unusual Activity Detection rules will instead be displayed in blue.

If live video is playing in a pane in the video window when an alarm occurs, the video
associated with the alarm will replace the live video. When the alarm is cleared, the original
live video will continue. If the original video is from a sequence or guard tour, the sequence
or tour continues in the background.

Acknowledge an alarm

Acknowledging an alarm indicates to Control Center that you are aware of the alarm and
you are dealing with it.
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You can only acknowledge an alarm after it has been escalated to you.

You can acknowledge alarms from:

A map
a. Right-click the zone in which the alarm has occurred and select Acknowledge.
b. Enter explanatory text if necessary.
c. Click OK. The alarm is acknowledged and the icon changes.

The Alarms panel
a. Select the alarm in the Alarms panel.

b. Click in the toolbar.

c. Enter explanatory text if necessary and click OK. The alarm is acknowledged and the icon
changes.

You may acknowledge more than one alarm at a time:

l To select consecutive alarms, click the first alarm, press and hold down the Shift key on
your keyboard, and then click the last alarm.

l To select non-consecutive alarms, press and hold down the Ctrl key on your keyboard,
and then click each alarm that you require.

l To select all alarms in the list, select one alarm, then press Ctrl+A on your keyboard.
The Alarms explorer

a. Right-click the zone in which the alarm has occurred from the Alarms explorer, and select
Acknowledge.

b. Enter explanatory text if necessary.
c. Click OK.

The video pane

If Control Center has displayed live video of an alarm which has just occurred, click the

arrow beside the alarm button in the video pane , and select Acknowledge Alarm.
The alarm overlay text turns yellow.

Clear an alarm

When you have taken the necessary action to deal with an alarm, you can clear the alarm.
You may need to enter text to explain the actions you took to resolve the alarm.

You can only clear an alarm after it has been escalated to you.

You can clear alarms from:
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A map
a. Right-click the zone in which the alarm has occurred and select Clear.
b. Enter explanatory text if necessary.
c. Click OK.

The Alarm explorer
a. Right-click the zone in which the alarm has occurred from the Alarms explorer, and select Clear.
b. Enter explanatory text if necessary.
c. Click OK.

The Alarms panel
a. Select the alarm in the Alarm panel.

b. Click in the toolbar.

c. Enter explanatory text, if necessary, and click OK. The alarm is no longer shown in the Alarms tab
in Live view.

You may clear more than one alarm at a time:

l To select consecutive alarms, click the first alarm, press and hold down the Shift key on
your keyboard, and then click the last alarm.

l To select non-consecutive alarms, press and hold down the Ctrl key on your keyboard,
and then click each alarm that you require.

l To select all alarms in the list, select one alarm, then press Ctrl+A on your keyboard.
The video pane

If Control Center has displayed live video of an alarm which has just occurred, click the
arrow beside the alarm button in the video pane, and select Clear Alarm . The alarm
overlay text turns green, and disappears after a few seconds.

Depending on how the alarm has been configured, Control Center may prompt a second,
authorized user to enter their password before the alarm is cleared.

Stop an alarm sound

Control Center may sound an alarm continuously when an alarm occurs. To turn off the
sound, you must acknowledge or clear the alarm.

View live video associated with an alarm

Control Center may automatically display video from a camera or salvo in a new video
pane when an alarm occurs. The alarm overlay text in the video pane is red to show that an
alarm has occurred. The overlay text turns yellow when the alarm is acknowledged.

You can also manually display video from an associated camera or a salvo where an alarm
has occurred, as follows:

1. Ensure you are in Live view.
2. Select the required alarm in the Alarms panel or on a map.

If the Alarms panel is not displayed, select Events > Alarms from the View menu or
double-click the Alarm status bar.
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3. Drag-and-drop the alarm into a video pane. Live video from the associated camera
or salvo is displayed in the pane.
The current layout may change if the salvo has a layout associated with it; if this is
the case, the salvo will start in the first pane of the selected video window.

For video of the alarm to be displayed, the camera must have been associated with a zone.

View recorded video associated with an alarm

Control Center may automatically display a looped replay from a camera or salvo in a new
video pane when an alarm occurs. The looped replay is displayed next to the live video

from the same camera. The looped replay icon is displayed in the video pane.

If Automatic NVR switching is enabled, there may be a brief pause during playback while
Control Center searches for an alternative NVR to play back footage from.

You can also manually display recorded video from an associated camera or a salvo where
an alarm has occurred.

To manually view recorded video associated with an alarm:

1. Ensure you are in Playback view.

2. Select the required alarm in the Alarms panel.

If the Alarms panel is not displayed, select Events > Alarms from the View menu or
double-click the Alarm status bar.

3. Drag-and-drop the alarm from the list into the playback window. This plays
back footage from the camera associated with the alarm starting from the time
of the alarm.

For video of the alarm to be displayed, the camera must be associated with a zone.

Play a pre-recorded message

You can manually play an imported pre-recorded audio message across a site, or through
a specific PA group or speaker in the area where an alarm has occurred.

To play a pre-recorded message:

1. Ensure you are in the Live view.

2. Right-click the required PA group, speaker or site in the Video or Alarms
explorer and select Send Audio Message... The Choose Audio Message
dialog opens.
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If you select a site, your announcement is broadcast through all speakers and PA groups in
that site.

3. Select a message and click OK.

To stop the audio message, right-click the item in the Video explorer and select Stop
Audio Message.

Carry out an action at any time

Control Center may have been configured so that you can perform certain actions, such as
opening a door, at any time, and not just when an alarm occurs. These actions are known
as relays.

To perform an action while viewing video from a particular camera
1. In Live view, display video from the required camera in a video pane.

2. Click the arrow beside to display a list of available actions.

A maximum of 4 relays are displayed per camera.

3. Select the required action from the drop-down list to perform it.

Depending on how the relay has been configured, Control Center may require a second,
authorized user to enter their password before the relay is activated.

To perform an action from a map
1. In Live view, display the map with the required relay.

2. Click the arrow beside to display a list of available actions.
3. Select the required action from the drop-down list to perform it.

Depending on how the relay has been configured, Control Center may require a second,
authorized user to enter their password before the relay is activated.

To perform an action at any time
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1. From the Live Video menu, select Actions.

2. Select All actions.
3. Choose the required action from the list and click Activate.

Depending on how the relay has been configured, Control Center may require a second,
authorized user to enter their password before the relay is activated.

View a map when an alarm occurs

You may want to view the relevant map containing a zone or detector when an alarm from
that zone occurs.

This can help you identify what has caused the alarm, and to acknowledge it if required.

To view a map when an alarm occurs, select Show Map on Alarm from the Alarms menu.

If you no longer want to view the map when an alarm occurs, repeat the steps above.

View an alarm procedure

Alarms may have a procedure associated with them which you should follow when the
alarm occurs, for example, there may be a set procedure in event of a fire alarm.

To view the alarm procedure:

1. In the Alarms panel, select the alarm whose procedure you want to view.
If the Alarms panel is not displayed, select Events > Alarms from the View menu or
double-click the Alarm status bar if it is displayed.

2. In the Alarms panel toolbar, click .
The procedure document opens.
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Authorize relay activation
Certain relays may have been protected, which means that a second user is required to
confirm that the relay should be activated.

When a user attempts to activate a protected relay, dialog is displayed requesting
authentication.

The authorized user must select their user name from the drop-down list and enter the
password they use to log into Control Center. If they do not normally enter a password
when logging in, they should enter the password they use to log into Windows.

The protected relays always require a second user to activate them. If you are currently
logged into Control Center, you cannot activate a protected relay yourself.

When they click OK, the relay is activated.

Authorize clearing an alarm
Certain zones may have been protected, which means that a second user is required to
confirm that alarms from these zones should be cleared.

When a user attempts to clear an alarm from a protected zone, a dialog is displayed
requesting authentication.

The authorized user must select their user name from the drop-down list and enter the
password they use to log into Control Center. If they do not normally enter a password
when logging in, they should enter the password they use to log into Windows.

If alarms from several protected zones are to be cleared at the same time, Control Center
prompts for authorization for each alarm.

Alarms for protected zones always require a second user to authorize them. If you are
currently logged into Control Center, you cannot authorize a protected alarm yourself.

Carry out an action at any time
Control Center may have been configured so that you can perform certain actions, such as
opening a door, at any time, and not just when an alarm occurs. These actions are known
as relays.

To perform an action while viewing video from a particular camera
1. In Live view, display video from the required camera in a video pane.

2. Click the arrow beside to display a list of available actions.

A maximum of 4 relays are displayed per camera.

3. Select the required action from the drop-down list to perform it.

4 How do I...? Control Center



Control Center Operator's Guide - v18.1 87

Depending on how the relay has been configured, Control Center may require a second,
authorized user to enter their password before the relay is activated.

To perform an action from a map
1. In Live view, display the map with the required relay.

2. Click the arrow beside to display a list of available actions.
3. Select the required action from the drop-down list to perform it.

Depending on how the relay has been configured, Control Center may require a second,
authorized user to enter their password before the relay is activated.

To perform an action at any time
1. From the Live Video menu, select Actions.

2. Select All actions.
3. Choose the required action from the list and click Activate.

Depending on how the relay has been configured, Control Center may require a second,
authorized user to enter their password before the relay is activated.
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Isolate or restore a detector
If you know that a detector is being activated incorrectly, for example, if a sensor is faulty,
you can isolate the detector to stop it causing an alarm. Once the problem has been
resolved, you need to restore the detector to restore normal operation.

You cannot isolate or restore a detector when a site is in offline mode. To isolate or restore
a detector, set the site back online.

To isolate a detector:

1. Right-click the detector in the Alarms explorer, or on a map.
2. Select Isolate and enter an explanatory text if necessary.

The detector icon changes to indicate that it is isolated

To restore a detector:

1. Right-click the detector in the Alarms explorer, the Detectors panel, or on a map.
2. Select Restore. The detector icon returns to normal.

Unset or set a zone
If you know that a zone is being triggered incorrectly, for example, during maintenance, or
you wish to turn off alarms during office hours, you can unset the zone to stop an alarm
occurring. To restore normal operation, you need to set the zone.

You cannot set, or unset a zone when a site is in offline mode. To set, or unset a zone, set
the site back online.

To unset a zone:

1. Right-click the zone in the Alarm explorer, or on a map.
2. Select Unset. The zone icon changes to indicate that it is unset.

To set a zone:

1. Right-click the zone in the Alarm explorer, or on a map.
2. Select Set. The zone icon returns to normal.

Find alarms
By default, the Alarms panel in the Playback view displays alarms that have occurred since
midnight of the previous day (that is, alarms from today and yesterday).

Alarms cannot be displayed when a site is in offline mode. To view alarms, set the site back
online.

To search for alarms:

1. In the Playback view, open the Alarms panel.
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If the Alarms panel is not displayed, select Events > Alarms from the View menu, or
double-click the Alarm status bar.

2. Click to open the Find Alarms dialog.

3. Specify which site you want Control Center to search in. This determines
which zones appear in the Zones list.

4. Select a zone and click to move it to the Selected list. To select all

zones in the site, click .

5. If required, specify which users last handled the alarms. Select a user or user

group and click to move it to the Selected list. To select all users

and user groups, click .

6. Specify the status of alarms for which you want to search.

7. Choose the required time period using the hour, day, week or month options,
or enter a custom time period.

8. Click OK. The alarms that match the search criteria are displayed in the list.
You can then export this information into a report about some or all of these
alarms.

Filter alarms
The Alarms panel in the Live view displays new and acknowledged alarms. You can filter
the alarms displayed in the Alarms panel to make it easier to focus on alarms from specific
areas.

Alarms cannot be displayed when a site is in offline mode. To view alarms, set the site back
online.

To filter alarms, in the Live view, select a predefined filter from the Filter drop-down list
above the Filter Selection panel. The filter determines what is displayed in the Filter
Selection panel, the Alarms panel, the Alarm status bar, maps and alarm groups.

Find activations
By default, the Activations panel in the Playback view displays activations that have
occurred since midnight of the previous day (that is, activations from today and yesterday).

Activations cannot be displayed when a site is in offline mode. To view activations, set the
site back online.

To search for activations:

1. In the Playback view, open the Activations panel.

If the Activations panel is not displayed, select Events > Activations from the View
menu, or double-click the Alarm status bar.

2. Click to open the Find Activations dialog.

3. Specify which site you want Control Center to search in.
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4. Select Selected detectors, All detectors in selected zones, or All detectors
for selected cameras.

5. Select a detector, zone or camera and click to move it to the

Selected list. To select all zones in the site, click .

6. If required, specify which users last handled the activations. Select a user and

click to move it to the Selected list. To select all users, click

.

7. Specify the status of activations for which you want to search.

8. Choose the required time period using the hour, day, week or month options,
or enter a custom time period.

9. Click OK. The activations that match the search criteria are displayed in the
list. You can then export this information into a report about some or all of
these activations.

Display event details
To display the details for an event:

1. Find the alarm you want to view and select it. The activations for the alarm are
listed in the lower section of the main window.

2. Right-click the alarm or the activation whose details you want to view, and
select View Details. The Alarm Details or Activation Details dialog opens.

The information about the alarm includes the status, the Alarm Server that have
logged the alarm, who acknowledged and cleared the alarm, and any notes taken.

Move the Events panels
The Events panels are located below the Control Center main window. To move the Events
panels, you can either undock or close and re-open them.

To undock an Event panel, click and hold the panel's title bar and move the panel
anywhere on the screen.

For more information about docking and moving panels, click here.

For more information about closing and opening the Events panels, click here.

View thumbnails of alarms
You can display thumbnails which display a still image from each time an alarm has
occurred. Each thumbnail contains the date and time that the image was recorded, and the
name of the zone the alarm occurred in.

To display the alarm thumbnails:

1. Click Alarm Thumbnails on the toolbar.
2. The alarm thumbnails for the current time range are displayed, including the time

and zone of the alarm. Double-click a thumbnail to start playing back video from that
point. To filter alarm thumbnails click in the header bar.
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View thumbnails of activations
You can display thumbnails which display a still image from each time an activation has
occurred. Each thumbnail contains the date and time that the image was recorded, and the
name of the detector which caused the activation.

To display the activation thumbnails:

1. Click Activation Thumbnails on the toolbar.
2. The activation thumbnails for the current time range are displayed, including the time

and detector for each activation. Double-click a thumbnail to start playing back video
from that point. To filter activation thumbnails click in the header bar.
For more information about filtering thumbnails, click here.

View alarms on the timeline
Alarms are shown on the timeline as vertical red lines. By default, the alarms displayed on
the timeline are the ones listed in the Alarms panel.

You can filter the alarms on the timeline to display all alarms listed in the Alarms panel, or
all alarms related to the camera selected in the Playback window. Right-click the timeline
and select one of the following options:

• Show alarms from the alarms list
• Show alarms related to the selected camera

Alarms are related to the selected camera by the zone in which the alarm is triggered.
When this option is chosen, the alarms displayed are determined by the video source
associated with the zone:

• Camera - if this camera is selected in the Playback window, the associated zone's
alarms are shown in the timeline.

• Salvo - if any camera in this salvo is selected in the Playback window, the
associated zone's alarms are shown in the timeline.

Initially, alarms are shown on the timeline. To view the timeline without alarms, select
Show Alarms from the Timeline menu. To re-display these lines, select Show Alarms from
the Timeline menu.

The total number of alarms for each time division is shown in red below the timeline.

To jump from one alarm to the next/previous, click or .

View activations on the timeline
Activations are shown on the timeline as vertical white lines. The activations displayed on
the timeline are the ones listed in the Activations panel.

Initially, activations are shown on the timeline. To view the timeline without activations,
select Show Activations from the Timeline menu.

To re-display these lines, select Show Activations from the Timeline menu.

To jump from one activation to the next/previous, click or .

View alarm counts
To display the total number of alarms that have occurred within a set time, select Show
Alarms from the Timeline menu.
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The alarm total for each time division (in this case, hours) is shown below the timeline.

View active detectors
The Detectors panel can be configured to display all active detectors.

1. Ensure you are in Live view.
2. Open the Detectors panel.

If the Detectors panel is not displayed, select Events > Detectors from the View
menu or double-click the Alarm status bar.

3. Right-click the Detectors panel and ensure Show Active is selected.
All active detectors are listed and the total count is displayed at the top of the list.

Select Hide Isolated Detectors to show only active detectors in the Detectors panel.

Create an alarm report
You may have searched through Control Center's list of alarms to find evidence of incidents
related to particular alarms. Control Center enables you to create reports containing
information about alarms of particular interest.

To create an alarm report:

1. In the the Alarms panel, click to display the Create Alarm Report dialog.
If the Alarms panel is not displayed, select Events > Alarms from the View menu or
double-click the Alarm status bar.

2. To include only currently selected alarms in the report, choose Selected alarms. To
include all alarms found using the previous search, select All queried alarms.

3. Select Include Activations to include all activations related to the alarms.
4. Enter a title for the report and select the preferred page size. (This option is only

available when you select RTF format reports in step 4). You can also add
comments about the report if required.

5. Specify what format the report will be saved in (CSV or RTF).
6. Click Browse... to specify a location for the report.
7. Click OK to create the report.

Create an activation report
You may have searched through Control Center's list of activations to find evidence of
incidents related to particular activations. Control Center enables you to create reports
containing information about activations of particular interest.

To create an activation report:

1. In the Activations panel, click to display the Create Activation Report dialog.
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If the Activations panel is not displayed, select Events > Activations from the View
menu or double-click the Alarm status bar.

2. To include only currently selected activations in the report, choose Selected
activations. To include all activations found using the previous search, select
All queried activations.

3. Enter a title for the report and select the preferred page size. (This option is
only available when you select RTF format reports in step 4). You can also
add comments about the report if required.

4. Specify what format the report will be saved in (CSV or RTF).

5. Click Browse... to specify a location for the report.

6. Click OK to create the report.

View alarm details
You can view full details of any alarm in the Alarm Details dialog. This shows the site where
the alarm occurred, the alarm name, the date and time the alarm occurred, and its current
status. Once the alarm has been acknowledged or cleared, any response notes entered
are displayed.

To view these details:

1. Select an alarm in the Alarms panel.
If the Alarms panel is not displayed, select Events > Alarms from the View menu or
double-click the alarm banner.

2. Click to display the Alarm Details dialog.

The response notes show comments that were added when the alarm was acknowledged
or cleared. The acknowledge response can be edited until the alarm is cleared.

To find out more about editing an acknowledge response, click here.

View unacknowledged alarms
New and acknowledged alarms are shown in bold red type in the Alarms panel.

To view alarms that have not been cleared, in the Live view, open the Alarms panel. Active
alarms are shown in the top pane, and the activations for the selected alarm are shown in
the bottom pane.

If the Alarms panel is not displayed, select Events > Alarms from the View menu or
double-click the Alarm status bar.

Edit an acknowledge response
A user can enter an acknowledge response when they acknowledge an alarm. You can
edit or enhance this response at any time until the alarm is cleared. If there is an existing
acknowledge response, it cannot be deleted and left blank.

This capability must be enabled for the Zone.
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To edit the acknowledge response:

1. Select an alarm in the Alarms panel.
If the Alarms panel is not displayed, select Events > Alarms from the View menu or
double-click the Alarm status bar.

2. Click to display the Alarm Details dialog.

3. Click to edit the acknowledge response.
The Response field becomes editable.

4. Click OK to save changes.

The acknowledge response cannot be modified after the alarm has been cleared.

View video for an event
You can configure Control Center to associate video to a detector. You can review the
recorded video for the event, at any time.

To view video for a particular event:

1. In the Playback view, select the Activations panel.

If the Activations panel is not displayed, select Events > Activations from the View
menu or double-click the Alarm status bar.

2. Click to display the Find Activations dialog.

3. Specify which site you want Control Center to search in. This determines
which detectors appear in the Available list. Select a detector and click

to move it to the Selected list. To select all detectors in the site, click
.

4. If required, specify the activation details.

5. Choose the required time period using the hour, day, week or month options,
or enter a custom time period.

6. Click OK to display the Activations in the Activations panel.

7. Select the activation from the list, then drag-and-drop it into a video pane.

Temporarily disable an alarm group video pane
You can temporarily disable an alarm group video pane. This ensures that alarms do not
interrupt you when watching video in a specific pane. This only affects the logged-in user
and resets each time Control Center is opened.

To temporarily disable the alarm group video pane:

In Live view, right-click the video pane you wish to temporarily stop from showing alarms and select Disable
Alarm Video.

If the Disable Alarm Video option is disabled, please contact your administrator.
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Work with bookmarks

Bookmarks overview
Users can add annotations to recorded video at specific times of interest, for example, to
mark evidence. These are known as video bookmarks. They are displayed on the timeline
by vertical magenta lines.

Bookmarks can be assigned a security level to ensure only authorized users can view
them. A user can view and add bookmarks at their security level and lower security levels.

You can display thumbnails which display a still image from each time a bookmark has
been added.

The Bookmark Comments window displays the comments for the bookmarks currently
displayed in the timeline.

Bookmarks cannot be used when a site is in offline mode. To use bookmarks, set the site
back online.

Add a bookmark
You can add bookmarks to recorded video at specific times of interest, for example to mark
evidence.

To add a bookmark to video footage:

1. In the Video explorer, select the camera with the footage that you want to bookmark.
Drag-and-drop the camera into a video pane.

2. Select Alt+C or right-click the video pane and select Add Bookmark...
The Add Bookmark dialog opens.
Alternatively, click
In Live view bookmarks are added at the current time. In Playback view bookmarks
are added at the cursor position of the recording playback.

3. Select the security level for the bookmark. 1 is the lowest, and 5 the highest security
level.

You can only select security levels that you are authorized to view.

4. Enter text to identify this bookmark, and click OK.

Select Alt+B or the Quick Add Bookmarks option to instantly add a bookmark with no
comment, and the highest security level available to you.

Delete a bookmark
You can delete bookmarks that you have added to recordings, but not those added by
other users.
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Users with full and restricted administrator rights can also delete bookmarks created by any
user.

To delete a bookmark:

1. Select the Bookmarks panel.

If the Bookmarks panel is not displayed, select Events > Bookmarks from the View
menu or double-click the Alarm status bar.

2. Select the bookmark you want to delete.

If the bookmark you want to delete is not shown, click to display the Find
Bookmarks dialog.

3. Press the Delete key on your keyboard. The bookmark is deleted.

View details of a bookmark
You can view details of bookmarks that have been added to recordings.

You can only view bookmarks that you are authorized to view.

To view details of a bookmark:

1. Select the Bookmarks panel.
If the Bookmarks panel is not displayed, select Events > Bookmarks from the View
menu or double-click the Alarm status bar.

2. Click the Show Details button in the Bookmarks panel to view the bookmark
details. If the bookmark whose details you want to view is not shown, click to
display the Find Bookmarks dialog.

If the Bookmark Overlay is displayed, bookmark comments are displayed in the video
pane.

View bookmarks in a video overlay
You can view bookmark comments in the video pane displaying the bookmarked footage
using the bookmark overlay.

You can only view bookmarks that you are authorized to view.

The bookmark overlay displays bookmark comments for the previous hour of footage with
the most recent bookmark at the top.
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The size of the text displayed in the bookmark overlay is determined by the default text
size.

To display the bookmark overlay:

1. Display the footage in a video pane.
2. Right-click the video pane and select Show Bookmark Overlay. The bookmark

overlay is displayed in the video pane.

View bookmark video
To view video that has been bookmarked:

You can only view bookmarks that you are authorized to view.

1. Select the Bookmarks panel.
If the Bookmarks panel is not displayed, select Events > Bookmarks from the View
menu or double-click the Alarm status bar.

2. Double-click the required bookmark to display the video. Alternatively, drag-and-
drop the required bookmark onto a video pane.
If the bookmark you require is not shown, click to display the Find Bookmarks
dialog.

Create a bookmark report
Control Center enables you to create reports containing information about bookmarks of
particular interest.

You can only view bookmarks that you are authorized to view.

To create a bookmark report:

1. In the Bookmarks panel, click to display the Create Bookmark Report
dialog.

If the Bookmarks panel is not displayed, select Events > Bookmarks from the View
menu or double-click the Alarm status bar.

2. To include only currently selected bookmarks in the report, choose Selected
bookmarks. To include all bookmarks found using the previous search, select
All queried bookmarks.

3. Enter a title for the report and select the preferred page size. (This option is
only available when you select RTF format reports in step 4). You can also
add comments about the report if required.

4. Specify what format the report will be saved in (CSV or RTF).

5. Click Browse... to specify a location for the report.

6. Click OK to create the report.
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Find bookmarks
In Live view, the Bookmarks panel displays bookmarks that have occurred since midnight
of the previous day (that is, bookmarks from today and yesterday).

You can only view bookmarks that you are authorized to view.

In Playback view, the Bookmarks panel displays the bookmarks displayed on the timeline.

To find a particular bookmark:

1. Select the Bookmarks panel.

If the Bookmarks panel is not displayed, select Events > Bookmarks from the View
menu or double-click the Alarm status bar.

2. Click to display the Find Bookmarks dialog.

3. Specify which site you want Control Center to search in. This determines
which cameras appear in the Available list. Select a camera and click

to move it to the Selected list. To select all cameras in the site, click
.

4. If required, specify which user created the bookmark. Select a user or user

group and click to move it to the Selected list. To select all users

and user groups, click .

5. Choose the required time period using the hour, day, week or month options,
or enter a custom time period.

6. To search using bookmark text, enter the required text in the Comments field.

7. Click OK to display the bookmarks in the Bookmarks panel.

Select bookmarks
To select all bookmarks in the Bookmarks panel:

You can only view bookmarks that you are authorized to view.

1. Make sure you are in Playback view.
2. Select the Bookmarks panel.

If the Bookmarks panel is not displayed, select Events > Bookmarks from the View
menu or double-click the Alarm status bar.

3. Use one of the following methods to select the required bookmarks:
• To select all bookmarks in the list, select one bookmark, then press Ctrl+A on your

keyboard.
• To select consecutive bookmarks, click the first bookmark, press and hold down the

Shift key on your keyboard, and then click the last bookmark.
• To select non-consecutive bookmarks, press and hold down the Ctrl key on your

keyboard, then click each bookmark that you require.
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View bookmarks on the timeline
Bookmarks are shown on the timeline as vertical magenta lines.

You can filter the bookmarks on the timeline to displayed all bookmarks listed in the
Bookmarks panel, or only those for the camera selected in the Playback window. Right-
click the timeline and select one of the following options:

• Show bookmarks from the bookmarks list
• Show bookmarks related to the selected camera

You can only view bookmarks that you are authorized to view.

Initially, bookmarks are shown on the timeline. To view the timeline without bookmarks,
select Show Bookmarks from the Timeline menu.

To re-display these lines, select Show Bookmarks from the Timeline menu.

To jump from one bookmark to the next/previous, click or .

Work with data records

Data records overview
Control Center can process data supplied from an external system. Each time an event
occurs on the external system a data record is created in Control Center.

In Control Center you can filter which data records you would like to view.

An external data source is a site object which represents a single source of data, and is
used to group data records. For example, a single till in a supermarket checkout. A data
record is a small piece of information that has been collected by the external data source
system. For example, a transaction at a checkout till in a supermarket.

Each external data source can be associated with a camera or a salvo. Therefore each
data record, from that external data source, will have a video stream or salvo associated
with that data record.

Find data records

You can only view data records that you are authorized to view.

Data records are events reported by an external system. The data records can be viewed
in the Data Records panel.

1. Select the Data Records panel.

If the Data Records panel is not displayed, select Events > Data Records from the
View menu or double-click the Alarm status bar.

Control Center 4 How do I...?



100 Control Center Operator's Guide - v18.1

2. Click to display the Find Data Records dialog.

3. Specify which site you want Control Center to search in. This determines
which external data sources appear in the Available list. Select a data source

and click to move it to the Selected list. To select all data sources in

the site, click .

4. Choose the required time period using the hour, day, week or month options,
or enter a custom time period (Playback view only)

5. To search using data record text, enter the required text in the Search Terms
field.

6. Click OK to display the data records in the Data Records panel.

Display data record details
To display the details for a data record:

1. Find the data record you want to view and select it.

2. Right-click the data record whose details you want to view, and select View
Details. The Data Record Details dialog opens.

The information about the data record includes the external data source name, the
date and time the data record was collected, and any text associated with the data
record.

View data record video
A video source can be configured with each data source. Data records from that data
source can then be used to view video from when each data record was created.

If you select a data record in Live view, the video displays the current stream.

1. Select the Data Records panel.
If the Data Records panel is not displayed, select Events > Data Records from the
View menu.

2. Double-click the required data record to display the video. Alternatively, drag-and-
drop the required data record onto a video pane.
If the data record you require is not shown, click to display the Find Data Records
dialog.

Work with sites

Change my home site
When your user account was created, you were allocated a home site. You may also have
access to other sites, which you may need to monitor. To view another site, you make it
your home site, as follows:

This is the site that you are required to monitor most frequently. When you log in, this is the
site that is automatically displayed. You have access to cameras and monitors in this site,
and any sub-sites.
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At any one time, you can see your home site and sites below it. You cannot view sites
above your home site, but you may also have access to other sites at the same level. If you
are authorized, you can change your home site to view objects in other sites.

1. From the File menu, select Change Home Site.

2. Select the site you want to view. The specified site appears in the Video
explorer.

You may not have full access permissions to all cameras and monitors in this site, for
example, you may not be able to play back recordings from cameras. Your user account
may have restricted access to devices in this site.

Working with alerts
Control Center displays warning and error messages in the Alerts panel. The number of
active alert messages is also displayed in the Alarm status bar.

Error

Warning

The alert messages notify users of an issue. After you have resolved the issue, you can
clear all alert messages navigating to the Alerts panel and click Clear.

You can only clear all alert messages. Use Copy To Clipboard to copy all alert messages
and paste them to a suitable file to ensure you have taken note of the messages before you
clear them.

Search your sites
Use the Site Search in Live and Playback view to search your sites for any camera,
sequence, salvo, or guard tour.

Administrators can also access Site Search in Setup view.

1. Open Site Search by selecting Ctrl+S shortcut key.
2. Start typing any part of the name or matrix number of the item you are looking for.

The list of available devices automatically filters based on the text you enter.
The item's location is displayed in a tooltip when you hover the cursor over it.

3. Use the arrow keys on your keyboard to highlight the item to view.
4. Press Enter to view video from the highlighted item in a video pane.

Alternatively, click , or select View > Site Search. Cameras can be dragged from Site
Search to a video pane.
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Rename a device

This functionality is only available if you have the permission to rename.

To rename a camera:

1. In Live or Playback view, right-click the device in the Video explorer.
2. Click Rename....
3. Click one of the options:

• Use Device Name to use the default name of the device.
• Use Custom Name to enter a new name for the device. The name can't be

longer than 64 characters.
4. Click OK.

The device name is updated in the Video explorer.

Work offline
Control Center sites can be configured to work offline when bandwidth to a site is restricted.
When in offline mode, Control Center does not automatically communicate with the
devices, NVRs, and Alarm Servers in the site.

When working offline, you can still initiate actions on devices in the site, for example, watch
live and recorded video, listen to additional audio streams, and broadcast audio. However,
alarms, bookmarks, motion search, and on-demand recording are not available.

Work offline

Control Center sites can be configured to work offline when bandwidth to a site is restricted.
When in offline mode, Control Center does not automatically communicate with the
devices, NVRs, and Alarm Servers in the site.

When working offline, you can still initiate actions on devices in the site, for example, watch
live and recorded video, listen to additional audio streams, and broadcast audio. However,
alarms, bookmarks, motion search, and on-demand recording are not available.

Set a site offline

You can set a site to work offline to stop automatic communication with the devices, NVRs,
and alarm servers in the site.

When you set a site offline, only your instance of Control Center is affected. If other
instances of Control Center are communicating with the devices in a site, they will continue
to do so.

To set a site offline:

1. Right-click the site in the Video explorer and select Work Offline.

The appearance of the site and all devices in the Video explorer changes.
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All child sites are also set offline.

To set a site back online:

1. Right-click the site in the Video explorer and select Work Offline.

The site and all devices appear as normal in the Video explorer.

Use a segmented site database
A segmented Control Center site database stores information for each site directly under
the top site in separate segments of the database. Site wide information, such as user
accounts, apply to all segments.

Operators and administrators can view and manage individual segments, or choose to
view all segments for an overview of the whole site. Full administrators can grant users
access to individual segments.

Change the active segment

When using a segmented site database, you need to specify which segment to use when
you login. To view video and alarms in a different site database segment, you must change
the active segment.

1. Select File > Log Out.
Segments are labeled by the name of the top site in the segment.

2. Choose the correct segment on the login dialog and login as normal.

You can only login to segments that you have been granted access to.

Work with cameras

Control a PTZ camera
Some cameras may have PTZ (Pan- Tilt- Zoom) functionality. You can control these
cameras using the Control Center interface or a CCTV keyboard.

Display video from the required PTZ camera in the video pane you want to use.

If you are using the Control Center interface to control the camera, click in the video pane to display a PTZ
control “grid” over the video. This grid indicates that you have successfully connected to the camera, and
provides pan, tilt and zooming functionality.
If you are using a CCTV keyboard, move the joystick to display a PTZ control “grid” over the video. This grid
indicates that you have successfully connected to the camera, and provides pan, tilt and zooming func-
tionality.
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If you are using the Control Center interface to control the PTZ camera, you can use the
PTZ Control Panel to access more functionality. To view the Control Panel, select View >
PTZ Controls.

Using a CCTV keyboard

Pan, tilt and zoom using a CCTV keyboard

For more detailed information, see the CCTV keyboard's documentation.

You can't use a CCTV keyboard to pan, tilt and zoom panomorph cameras

Pan and tilt
Move the joystick until the camera reaches the required position.

To move the camera faster, move the joystick further away from the center.
To move the camera more slowly, move the joystick closer to the center.

As you move the joystick, the PTZ camera simultaneously pans and tilts in the specified
direction and at the specified speed.

When the camera reaches the maximum pan or tilt range, the movement stops, even if you
continue to tilt the joystick. To start moving the camera again, move the joystick in the
opposite direction.

Zoom

To zoom in, twist the joystick clockwise.
To zoom out, twist the joystick counter-clockwise.

For Panasonic WV-CU650 keyboards, use the zoom wheel at the top of the joystick.

Refocus a camera using a CCTV keyboard

For more detailed information, see the CCTV keyboard's documentation.
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IndigoVision v1 Keyboard

IndigoVision domes run in auto focus mode by default and in most cases manual focus
control is not required.

If manual focus adjustment is required, press either focus near or focus far as

required. To auto focus again, press .

IndigoVision Surveillance Keyboard

IndigoVision domes run in auto focus mode by default and in most cases manual focus
control is not required.

If manual focus adjustment is required, press FOCUS+ or FOCUS- as required. To auto
focus again, press AFOCUS.

American Dynamics ADCC1100 Keyboard

If manual focus adjustment is required, press either focus near or focus far as required.

American Dynamics AD2088 (Sensormatic) Keyboard

To refocus a camera, press and hold the NEAR or FAR key on the keyboard.

Pelco KBD300A Keyboard

To refocus a camera, press and hold the NEAR or FAR key on the keyboard. The camera
keeps refocusing in the required direction until you release the key.

Pelco CM9760-KBD Intelligent Keyboard

To refocus a camera, press and hold the NEAR or FAR key on the keyboard. The camera
keeps refocusing in the required direction until you release the key.

Panasonic WV-CU650 Keyboard

To refocus a camera, press and hold the NEAR or FAR key on the joystick. The camera
keeps refocusing in the required direction until you release the key.

To auto-focus, press the button on the top of the joystick.

Move to a preset PTZ position using a CCTV keyboard

For more detailed information, see the CCTV keyboard's documentation.

IndigoVision v1 Keyboard

Enter the preset number on the keypad, followed by . Alternatively, if the preset

required is between 1 and 5, press any of the 'Quick Preset' buttons (eg ).

IndigoVision Surveillance Keyboard

Press GPRESET, enter the preset number on the keypad, followed by E .
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American Dynamics ADCC1100 Keyboard

Enter the preset number on the keypad, followed by the soft key.

American Dynamics AD2088 (Sensormatic) Keyboard

Enter the preset number on the keypad, then press the PRESET key.

Pelco KBD300A Keyboard
1. Enter the preset number on the CCTV keyboard.
2. Press PRESET to move the camera to the preset position.

Pelco CM9760-KBD Intelligent Keyboard
1. Enter the preset number on the CCTV keyboard.
2. Press PRST to move the camera to the preset position.

Panasonic WV-CU650 Keyboard

Enter the preset number on the keypad, then press the PRESET key.

Adjust a camera's iris using a CCTV keyboard

For more detailed information, see the CCTV keyboard's documentation.

IndigoVision v1 Keyboard

IndigoVision domes run in auto iris mode by default and in most cases manual iris control is
not required.

If manual iris adjustment is required, press either open iris or close iris as

required. To revert to auto iris control again, press .

IndigoVision Surveillance Keyboard

IndigoVision domes run in auto iris mode by default and in most cases manual iris control is
not required.

If manual iris adjustment is required, press either IRIS+ or IRIS- as required. To revert to
auto iris control again, press AIRIS.

American Dynamics ADCC1100 Keyboard

If manual iris adjustment is required, press either open iris or close iris as required.

American Dynamics AD2088 (Sensormatic) Keyboard

To adjust the iris, press and hold the OPEN or CLOSE key on the keyboard.

Pelco KBD300A Keyboard

To adjust the iris, press and hold the OPEN or CLOSE key on the keyboard.

Pelco CM9760-KBD Intelligent Keyboard

To adjust the iris, press and hold the OPEN or CLOSE key on the keyboard.
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Panasonic WV-CU650 Keyboard

To adjust the iris, press and hold the OPEN or CLOSE key on the joystick.

Clear error messages using a CCTV keyboard

• IndigoVision v1 Keyboard
To clear error messages that appear in the Alerts panel, press A1 on the keyboard.

• IndigoVision Surveillance Keyboard
To clear error messages that appear in the Alerts panel, press CLOSE on the keyboard.

• American Dynamics ADCC1100 Keyboard

To clear error messages that appear in the Alerts panel, press the soft key on the keyboard.
• American Dynamics AD2088 (Sensormatic) Keyboard

To clear error messages that appear in the Alerts panel, press ACK on the keyboard.
• Pelco KBD300A Keyboard

To clear error messages that appear in the Alerts panel, press ACK on the keyboard.
• Pelco CM9760-KBD Intelligent Keyboard

This function is not supported by this keyboard.
• Panasonic WV-CU650 Keyboard

To clear error messages that appear in the Alerts panel, press ACK on the keyboard.

Work with PTZ camera menus using a CCTV keyboard

IndigoVision v1 Keyboard

To obtain access to the PTZ camera menu system, press and hold , then press ‘1’,
‘2’, ‘3’.

To navigate the menus use the joystick on the keyboard. Move the joystick left, right, up
and down to move the cursor, and twist it clockwise to activate the selected item.

IndigoVision Surveillance Keyboard

To obtain access to the PTZ camera menu system, press MONITOR, enter a monitor or

video pane number, press E , then press MENU.

To navigate the menus use the joystick on the keyboard. Move the joystick left, right, up
and down to move the cursor, and twist it clockwise to activate the selected item.

American Dynamics ADCC1100 Keyboard

PTZ camera menus are only available when an Administrator level smart card is inserted
into the back of the keyboard.

a. Enter a monitor or video pane number, and press . Then enter the number of the camera

whose menus you want to view, then press .

b. When the camera is displayed on screen, press the orange Program Mode key on the keyboard.
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c. Press the soft key (Dome Menu). The camera's configuration menu appears on the mon-
itor/video pane. To navigate the menus use the joystick on the keyboard. Move the joystick left,
right, up and down to move the cursor, and twist it clockwise to activate the selected item.

When you press the menu soft key, the LCD display on the keyboard changes to show 2
buttons (Enter and Save & Exit). Pressing these has no effect. To exit the camera menu
use the joystick to navigate to the Exit option, then press the orange Operator key on the
keyboard to return to the standard keyboard menu options.

American Dynamics AD2088 (Sensormatic) Keyboard

PTZ camera menus are not supported.

Pelco KBD300A Keyboard

PTZ camera menus are not supported.

Pelco CM9760-KBD Intelligent Keyboard

PTZ camera menus are not supported.

Panasonic WV-CU650 Keyboard

To obtain access to the PTZ camera menu system, press the MENU key. Use the joystick
to navigate the menus. Twist the zoom wheel clockwise to activate the selected item

Using the Control Center interface

Panning, tilting and zooming using the mouse

You can use the mouse to pan, tilt an zoom the PTZ cameras.

Panomorph cameras can be dewarped using a mouse to pan, tilt and zoom around the
image in a video pane.

When a panomorph camera is started in a video pane, an overview 360-degree image is
shown. To pan or tilt around the image, zoom in on the image first.

Panning and tilting

Panning and tilting PTZ cameras
Click and hold the left mouse button and move the mouse in the direction you want to move
the camera.

l To move the camera faster, move the mouse further away from the center of the video pane.
l To move the camera more slowly, move the mouse closer to the center of the video pane.

The cursor shape changes to show which direction the camera is panning and/or tilting.

As the mouse is moved, the PTZ camera simultaneously pans and tilts in the specified
direction and at the specified speed. The further away the cursor is moved from the center
of the video pane, the faster the movement.

4 How do I...? Control Center



Control Center Operator's Guide - v18.1 109

When the camera reaches the maximum pan or tilt range, the movement stops, even if you
continue to hold down the mouse button. To start moving the camera again, move the
mouse in the opposite direction.

Panning and tilting panomorph cameras
Click and hold the left mouse button, and move the mouse in the direction you want to
move the camera.

When you move the mouse, the video is continuously dewarped.

Zooming in and out

Zooming PTZ cameras
Use the scroll wheel to zoom in and out.

Alternatively, click the left side of the center rectangle on the video pane to zoom in, or click
the right side of the center rectangle on the video pane to zoom out. The cursor changes
shape to show that the camera is zooming in or out.

Zooming panomorph cameras
Use the scroll wheel to zoom in and out.

Refocus a camera using the Control Panel

You can refocus a camera using the PTZ Control Panel. If you have closed it, select PTZ
Controls from the View menu.

If your camera does not support focus control, the focus control buttons are not available. If
the camera supports either manual focus or auto focus but not both, only the focus control
button for the supported option is available.

In the PTZ Control Panel, press or to refocus near or far respectively.

To refocus by a small amount, press the button once.
To refocus continuously, press and hold the button down. The camera keeps refocusing in the required dir-
ection until you release the button.

To auto focus the camera, press .

Move to a preset PTZ position using the PTZ Control Panel

Control Center's PTZ Control Panel enables you to move the PTZ camera to preset
positions at the touch of a button. The first nine presets are shown as numbered buttons on
the panel.

If you have closed the Control Panel, select PTZ Controls from the View menu to re-open it.

To move to a preset position, click the preset button once to carry out the action. The
buttons may display additional information explaining the position in more detail. Move the
mouse over the button to display this text.

If there are more than nine presets, click the arrow beside the drop-down list, select the

required preset, and click .
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Adjust a camera's iris using the PTZ Control Panel

You can adjust a camera's iris using the PTZ Control Panel. If you have closed it, select
PTZ Controls from the View menu.

If your camera does not support iris control, the iris control buttons are not available. If the
camera supports either manual iris or auto iris but not both, only the iris control button for
the supported option is available.

In the PTZ Control Panel, press to open the iris, and to close the iris.

To adjust the iris by a small amount, press the button once.
To adjust continuously, press and hold the button down. The camera's iris will continue to open or close until
you release the button.

Press to use the camera's auto iris function.

Perform PTZ custom actions

The PTZ Control Panel may contain controls which enable you to perform certain actions
with the PTZ camera. The first six of these are shown as buttons.

Click the required button. Alternatively, if there are more than six actions, select the

required action from the list, and click .

Hold the connection to all PTZ cameras

Control Center may have been configured to allow you to hold the connection to a PTZ
camera, and prevent other users from controlling it.

By holding the connection to one PTZ camera, the connections to all PTZ cameras
displaying video are held, and the cameras cannot be controlled by other users.

Press to hold all PTZ cameras in their current position, and prevent other users from
controlling them. The icon changes to when you are holding the PTZ connections.

Click the button again to release the cameras and free them up for other users to control.

Work with PTZ camera menus using Control Center

To use Control Center to access camera menus:

1. In Live view, display video from the camera in a video pane. The PTZ Control
Panel becomes accessible.

You may find it useful to maximize the video pane to allow easier access to the
menu.

2. Click in the Control Panel to display the PTZ camera menu in the video
pane.
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If the camera does not have a menu, this button is not active.

3. To move the screen selection up or down, click in the top or bottom half of the
video pane as required.

4. To select a menu item, click in the on-screen menu to the left of center. The

cursor changes to when the cursor is in the correct potion.

To move back to the previous level, select Return on the menu. To exit the menu
completely, select Exit.

Work with audio

Listen to audio

Listen to additional audio sources

Control Center allows you to listen to an audio source independently of the video currently
displayed. This enables you to listen to an audio source from a camera without displaying
the video, or to listen to more than one audio source associated with a single video.

To listen to additional audio sources in Playback view, you must activate Synchronized
mode.

To listen to multiple additional audio sources without displaying video:

Control Center 4 How do I...?



112 Control Center Operator's Guide - v18.1

1. Click Live Menu > Configure Extra Audio... The Extra Audio Sources dialog opens.

2. Select an audio source from the Available list and click . Or click
to add all audio sources.
To remove an audio source, select the audio source from the Selected list and click

. Or click to remove all audio sources.
3. Click OK. The dialog closes and the selected audio sources start playing.

When you change views, for example, from the Live view to the Playback view, audio stops
playing. The audio will start playing again when you return to the original view.

To listen to the audio from a single camera without displaying video:

• Right-click a camera in the Video explorer and select Listen as Extra Audio.
The additional audio source starts playing.

Work with audio in a recording

When you start viewing a recording in a video pane, audio is automatically enabled. This is

indicated by at the bottom right of the pane.

To turn audio off, click in the bottom right of the pane. Click to enable it
again.

Alternatively, click in the timeline to enable audio in the selected pane and disable it in all
other panes. Click in the timeline to enable audio in all panes currently displaying video.

Broadcast audio
Control Center uses Opus encoding to broadcast messages to third party cameras. If the
camera does not support Opus messages, then G.711 encoding is used.

Broadcast an announcement

You can broadcast an announcement across a site, or through a specific PA group or
speaker.

To broadcast an announcement:

1. Ensure you are in the Live view.

2. Right-click the required PA group, speaker, or site in the Video explorer and
select Page.

If you select a site, your announcement is broadcast through all speakers and PA groups in
that site.

3. Use the microphone connected to your PC to make your announcement.
When you have finished your announcement, click Stop.
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Interact with someone I see on screen

There may be occasions when you need to interact with people you view on screen.
Control Center provides audio functionality to enable you to speak and listen to people you
view in a particular location.

You can listen to more than one video pane at once. If you are using multiple windows, you
can listen to audio from all windows. However, you can only speak through your
microphone to one camera at a time.

In Live view:

To speak to someone you view on camera, right-click in the video pane and select Speak. Alternatively, click
in the pane displaying video from the camera.

To listen to someone you view on camera, right-click in the video pane and select Listen. Alternatively, click

in the pane displaying video from the camera.

Play a pre-recorded message

You can manually play an imported pre-recorded audio message across a site, or through
a specific PA group or speaker in the area where an alarm has occurred.

To play a pre-recorded message:

1. Ensure you are in the Live view.

2. Right-click the required PA group, speaker or site in the Video or Alarms
explorer and select Send Audio Message... The Choose Audio Message
dialog opens.

If you select a site, your announcement is broadcast through all speakers and PA groups in
that site.

3. Select a message and click OK.

To stop the audio message, right-click the item in the Video explorer and select Stop
Audio Message.

Work with external tools

Run a report
You can run reports from within Control Center.

To run a report:

1. From the Tools menu, select Reports...The Reports dialog opens.
2. Select the required report from the list and click Run... The report opens in the

appropriate reporting application.
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If configured, when you select Tools > Reports... you can access the web- based
IndigoReports server and can configure your reports using this tool.

► For more information, refer to the IndigoReports Administrator Guide.

Run an external tool
Control Center may have been set up to allow you to run other applications when viewing a
camera in Live view. For example, it may allow you to control something in view of the
camera, such as opening a door.

To run one of these applications:

1. In Live view, drag-and-drop the camera you require into a video pane.

2. Click the button for the application you want to run at the bottom of the main
window.

3. The application opens.

The application remains open until you close it. Control Center does not
automatically close applications when you shut down Control Center.

View stream statistics
To view details of frame rate, resolution, and video/audio bit rates for a live video stream,
select Show Stream Statistics from the Live Video menu.

Statistics are shown for all cameras which are currently displaying video on screen.

View a web page
You can display a configured Web Page in either the Live or Playback view:

1. Select the required Web Page from the View > Other menu.
The selected Web Page is shown in a new panel.

2. Move, dock or pin the Web Page panel as required.

The back, forward, refresh and home buttons on the Web Page panel can be used for
navigation similar to a standard web browser.
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Lock out users

Lock out other users
When a major incident occurs, Control Center allows an authorized investigator to
immediately take control of the system and lock all other users out, preventing them
viewing video from a set of cameras and accessing recordings from those cameras. This is
known as "video lockout".

Authorized investigators can only lock out IndigoVision protocol cameras and transmitters.

To lock out other users, you must have been given video lockout permission.

What do you want to do?

Lock out all users
Release lockout

Lock out all users
When you lock out all users, you immediately take control of the system and prevent all
other users from viewing video from a set of cameras. To do this, you must have been
given video lockout permission.

You can only lock out other users from IndigoVision protocol cameras and transmitters.

To lock out users from a single camera
1. In Live view, right-click the camera you want to prevent users from viewing in the

Video explorer.

2. Select Lock out Camera. The camera is shown as in the Video explorer.
3. To release the camera and make it available again to other users, right-click the

camera in the Video explorer, and select Release Camera.

To lock out users from all cameras in a site
1. In Live view, right-click the site containing the cameras you want to prevent users

from viewing in the Video explorer.

2. Select Lock out All Cameras. Locked out cameras are shown as in the Video
explorer.

3. To release the cameras and make them available again to other users, right-click the
site in the Video explorer and select Release All Cameras.
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Release lockout

To prevent other users from accessing cameras (lockout), you must have been given Video
Lockout permission.

You may have used video lockout to prevent users from accessing one or more cameras
and from viewing recordings from those cameras. To allow them to access the cameras
again, you must release the cameras.

To release a single camera
1. In Live view, right-click the locked camera in the Video explorer.

2. Select Release Camera. (Locked cameras are shown as in the Video
explorer.)

3. Video from the locked camera is restarted.

To release all cameras in a site
1. In Live view, right-click the site containing the locked cameras in the Video explorer.

2. Select Release All Cameras. (Locked cameras are shown as in the Video
explorer.)

3. Video from the locked cameras is restarted.
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5 TROUBLESHOOTING

Alarms and relays

How do I know an alarm has occurred?
The alarm appears in red type and the alarm icon flashes in the Alarm status bar. It is initially unac-
knowledged.
The Video explorer icon for the zone in which the alarm occurred changes to reflect the zone's status.
The alarm sound is activated (if this has been configured). You may hear either a single sound or a con-
tinuous alarm, depending on how this has been set up.
A map of the site where the alarm has occurred may be displayed. The zone or detector on the map will
flash, and the associated area is highlighted if defined.
Live video from the camera or salvo associated with the alarm is automatically displayed in an alarm group
window, if configured. The alarm overlay in the video pane is colored red, or bolded depending on the cam-
era, to indicate that it has been displayed in response to an alarm. Alarms generated from Unusual Motion or
Unusual Activity Detection rules will instead be displayed in blue.

If live video is playing in a pane in the video window when an alarm occurs, the video
associated with the alarm will replace the live video. When the alarm is cleared, the original
live video will continue. If the original video is from a sequence or guard tour, the sequence
or tour continues in the background.

Why does the alarm sound continue?
While there are new alarms not yet acknowledged the alarm alert icon flashes and the
alarm sound continues to be heard.

I can't clear an alarm
There are a few scenarios that may prevent you from clearing an alarm:

• You cannot clear an alarm if a detector in the zone is still active. You must first
resolve the event that activated the detector before you clear the alarm. For
example, if a door opening triggered the alarm, you must close the door to return the
detector to a normal state.
You can view a list of all active detectors in the Detectors panel.
If the detector is faulty, an administrator can isolate the detector until it is repaired to
ensure it does not trigger an alarm.

• Protected alarms always require a second user to authorize them. They should
select their user name from the drop-down list and enter the password they use to
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log into Control Center. If they do not normally enter a password when logging in,
they should enter the password they use to log into Windows.

If you are currently logged into Control Center, you cannot authorize a protected alarm
yourself.

• You can only clear alarms that are at your escalation level or above.
If the zone icon in the Video explorer indicates that the zone is in alarm, but the
alarm is not displayed in the Detectors panel, the alarm has not been escalated to
you. Contact an administrator for more information about the escalation policy.

I can't activate a relay
The relay may be protected, and require a second, authorized user, to activate it.

The authorized user should select their user name from the drop-down list and enter the
password they use to log into Control Center. If they do not normally enter a password
when logging in, they should enter the password they use to log into Windows.

Protected relays always require a second user to activate them. If you are currently logged
into Control Center, you cannot activate a protected relay yourself.

A looped replay is not displayed when an alarm occurs

These remedies are only available if you have administrator permissions.

• If live video is displayed when an alarm occurs, but no looped replay for the camera
is displayed, the zone or detector may not be configured to display looped replay.

• If the looped replay pane is displayed, but no replay footage is available, there may
be no 24/7 recording job created for the camera or salvo.

CCTV keyboards

Video does not appear in video pane when using a CCTV keyboard
When displaying video in a video pane using the CCTV keyboard, Control Center uses
each video pane's matrix number to determine where the video should be displayed. If
video does not appear in the required pane, please check with your administrator.

Clear error messages using a CCTV keyboard
• IndigoVision v1 Keyboard

To clear error messages that appear in the Alerts panel, press A1 on the keyboard.
• IndigoVision Surveillance Keyboard

To clear error messages that appear in the Alerts panel, press CLOSE on the keyboard.
• American Dynamics ADCC1100 Keyboard
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To clear error messages that appear in the Alerts panel, press the soft key on the keyboard.
• American Dynamics AD2088 (Sensormatic) Keyboard

To clear error messages that appear in the Alerts panel, press ACK on the keyboard.
• Pelco KBD300A Keyboard

To clear error messages that appear in the Alerts panel, press ACK on the keyboard.
• Pelco CM9760-KBD Intelligent Keyboard

This function is not supported by this keyboard.
• Panasonic WV-CU650 Keyboard

To clear error messages that appear in the Alerts panel, press ACK on the keyboard.

Live video

I can't control a PTZ camera
This may be for the following reasons:

Your user account may have been allocated a priority value, used when controlling PTZ cameras. Users with
a higher priority are able to take control of a PTZ camera you are using.

Control Center alerts you that you have lost control of the camera, and indicates
which user now has control.
If the user controlling the camera does not move it for five seconds, you can regain
control of it.

Your user account may not have been authorized to use this camera. If this is the case, the PTZ Control
Panel will be unavailable and no PTZ grid appears on the video pane.
Another user may be "holding" the connection to a PTZ camera. If this is the case, you must wait until they
have released the camera before you can control it again.
An authorized user may have locked this camera in the event of a major incident. This means that you are
no longer able to access it. Control Center notifies you that this has happened.

PTZ-capable ONVIF cameras are indicated by the PTZ icon if the chosen media profile has the con-

tinuous PTZ setting enabled, otherwise it is indicated by a Fixed icon .
You can configure an ONVIF camera using the ONVIF Configuration Utility provided
with Control Center.

A camera I'm viewing has been locked out
If Control Center notifies you that one or more cameras are locked out, this means that an
authorized investigator has taken to control of the system (usually in the event of a major
incident) and has locked all other users out.

This means that you are no longer able to access any locked cameras. Control Center
notifies you when the lockout has been released.

I can't view video from a camera
This may be for one of the following reasons:

1. You do not have permissions from your administrator to view video from this camera
2. The camera is unavailable
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3. The camera is unlicensed

Contact your administrator with details of the issue.

If you do not have permissions to view video, Control Center displays the following:

• In the Alerts panel, Control Center displays the following error message:
Insufficient access permissions to perform the requested
operation on [(device matrix number)] (device name)

The following permissions are required: View

If the camera is unavailable, Control Center displays the following:

• In the Video Explorer panel, Site Search window, and any maps the camera is on,
Control Center displays a gray camera icon with a red cross.

• In the Alerts panel, Control Center displays the following error message:
Unable to show video from [(device matrix number)] (device
name)

If the camera is unlicensed, Control Center displays the following:

• In the Video Explorer panel, Site Search window, and any maps the camera is on,
Control Center displays an unlicensed camera icon.

• In the Alerts panel, Control Center displays the following error message:
Insufficient access permissions to perform the requested
operation on [(device matrix number)] (device name)

The following permissions are required: View

► For more information about licensing, see "Licensing Overview" on page 16

I can't start an external tool
To start an external tool from Control Center, make sure:

Live view is displayed.
You have selected a video pane in which live video is displayed.

I get an error when I run an external tool
If you click a button for an external tool and an error message appears, it may be that the
tool has not been set up correctly to run from Control Center. Contact your administrator for
more information.

I get feedback when talking to someone on screen
If you experience feedback when interacting with someone you view on screen, you should
disable simultaneous listen and speak.

To disable simultaneous listen and speak:

1. From the Tools menu, select Options.

2. Select the Video and Audio tab.

3. Select Prevent simultaneous listen and speak.

4. Click OK.
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Your Operating System may require this change to be authorized.

Live video is jerky
Jerky live video may be caused by jitter due to a large amount of traffic on the network. If
this is the case, you can configure Control Center to add additional buffering to the live
video in order to achieve smoother rendering.

To introduce a delay for live video rendering:

1. From the Tools menu, select Options.
2. Select the Video and Audio tab.
3. Specify the time delay in milliseconds in the Video buffer length field.
4. Click OK.

Your Operating System may require this change to be authorized.

I see my user name over the top of the live video
Your administrator set the user name watermarking feature for your account.

When you view live and recorded video in Control Center, the watermarking overlay is
displayed.

Motion search

Timing of peaks on museum mode motion search
In museum mode, you may find that motion peaks do not occur at the point where an object
is added to or removed from the scene.

Instead, the motion profile starts to register the addition or removal of the object at the time
when the scene changes. The peak occurs when the integration time period has passed.

For example, you may want Control Center to register when a suitcase is left for longer
than half a minute in a scene at an airport. In this case, you would set up a museum mode
motion search with an integration time of 30 seconds. If a suitcase is placed in the scene,
the motion search will register that it is there. If it is still there 30 seconds later, the motion
search profile will show a peak at this time (30 seconds after the suitcase was left in the
scene).
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Motion search object size does not act as expected
When you set a maximum object size, you may find that not all objects above this size are
filtered out. This is because Control Center may see large objects as being made up of
several smaller objects, especially if the large objects has lighter or darker areas in it.

Also, if you set a large minimum object size, the motion search may not detect some motion
because an object you see as larger than the minimum size may be perceived as several
smaller objects, and therefore filtered out.

Rectangles are not displayed around motion

If you are logged in as an operator
Contact the administrator.

If you are logged in as an administrator

If you have pressed in a live video pane, and do not see rectangles around areas of
motion or a motion trace, check that the camera you are using supports motion detection
and that it is configured to send analytics information.

To configure a camera to send analytics information, refer to the camera documentation.

This feature is not available on all IndigoVision cameras, and is available on some ONVIF
cameras. For more information, please refer to the camera documentation.

I can't see a motion profile in the timeline
• If you have tried to create a motion profile, but no motion is shown in the timeline, the

system administrator may need to adjust the frame settings for that device.
• Make sure Control Center is enabled to display motion on the timeline (Timeline >

Show Motion Profile).
• There may not be any motion in the scene. Check if the yellow line is not appearing

at the bottom of the timeline.
• Control Center may be unable to perform motion analysis. Check if an orange bar is

displayed at the top of the timeline. In this case, you may need to adjust the frame
settings.

• The motion search options may not be set up correctly. This may mean that there is
motion but Control Center is ignoring. For example, it may have been set up to
ignore motion in an area instead of detecting it.

• Motion search is not available for footage recorded in M-JPEG format.

Passwords

I've forgotten my password
Contact your administrator and request a new password.
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Change password
As an operator, you can't change your password in Control Center. Contact your
administrator and request a new password.

Which password should I use?
If you are logging in as an operator, and have been allocated a password, you must use
this with your login name.

If logging in as an administrator, use the administrator password which you set during
installation.

Recordings

A saved recording is shorter than expected
When exporting a recording, the length of recording you have saved may be shorter that
you expected.

This may be for one of the following reasons:

• There are gaps in the recorded footage so that the total duration of the saved
recording is less than requested.
This may be because:
• Scheduled recordings may result in times where there are no recordings for the

parts of the requested time period.
• The network connection between the camera and the recorder (NVR) was lost

during some of the requested time period.
• The camera was turned off during some of the requested time period.

• You have requested a timespan that is longer than the actual recorded footage.

The time shown on the timeline appears to be incorrect
The time shown for a recording in Playback view is determined by the local time of the site
to which the camera belongs, not by the PC on which it is being viewed. The timezone is
shown in the status bar below the application. e.g. (GMT -5:00) Eastern Time US and
Canada.

I can't select the CD drive when saving a recording
When saving a recording to a CD, Windows first saves the recording to a temporary
location.

Recorded video is jerky and/or slow when played back
If recorded video is jerky and/or slow, this may be because your network is unable to cope
with the speed at which the video is being streamed.

If this is the case, you can specify that Control Center periodically pauses the video until
there is enough data to play smoothly at the correct speed rather than playing erratically at
a slower speed.
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To enable buffered playback:

1. From the Tools menu, select Options.
2. Select the Video and Audio tab.
3. Select Use buffered playback.
4. Click OK.

Your Operating System may require this change to be authorized.

I can't see a motion profile in the timeline
• If you have tried to create a motion profile, but no motion is shown in the timeline, the

system administrator may need to adjust the frame settings for that device.
• Make sure Control Center is enabled to display motion on the timeline (Timeline >

Show Motion Profile).
• There may not be any motion in the scene. Check if the yellow line is not appearing

at the bottom of the timeline.
• Control Center may be unable to perform motion analysis. Check if an orange bar is

displayed at the top of the timeline. In this case, you may need to adjust the frame
settings.

• The motion search options may not be set up correctly. This may mean that there is
motion but Control Center is ignoring. For example, it may have been set up to
ignore motion in an area instead of detecting it.

• Motion search is not available for footage recorded in M-JPEG format.

Nothing is displayed in the timeline
When a site is in offline mode, Control Center does not receive information about the
recorded footage from the NVR. Therefore, Control Center cannot display information
about the recording, or the alarms and bookmarks associated with the recording.

To view this information, an administrator needs to set the site back online.

I can't see all the bookmarks available
You can only view bookmarks at your security level or below.

► For more information, see "Bookmarks overview" on page 1

I can't playback video from a camera
This may be for one of the following reasons:

1. You do not have permissions from your administrator to playback video from this
camera

2. The camera is unlicensed
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Contact your administrator with details of the issue.

If you do not have permissions to playback video, Control Center displays the following:

• In the Alerts panel, Control Center displays the following error message:
Insufficient access permissions to perform the requested
operation on [(device matrix number)] (device name)

The following permissions are required: Playback

If the camera is unlicensed, Control Center displays the following:

• In the Video Explorer panel, Site Search window, and any maps the camera is on,
Control Center displays an unlicensed camera icon.

• In the Alerts panel, Control Center displays the following error message:
Insufficient access permissions to perform the requested
operation on [(device matrix number)] (device name)

The following permissions are required: Playback

► For more information about licensing, see "Licensing Overview" on page 16

I see my user name over the top of the recorded video
Your administrator set the user name watermarking feature for your account.

When you view live and recorded video in Control Center, the watermarking overlay is
displayed.

Salvos, sequences and guard tours

Guard tour does not display all cameras in a salvo
Guard tours do not "wrap" from the end of the video panes to the start.

For example, you may have started a guard tour in pane 7 of 9 (9-pane layout). If one of the
salvos in the guard tour contains five cameras, only the first three will be shown - in panes
7,8 and 9. The remaining two cameras are not shown.

To view these cameras, start the guard tour in a pane between 1 and 5, or change the
layout to display more video panes.

I can't change the position of a guard tour
This may be because:

The position of the guard tour cannot be changed while it is running. To change the pane in which a guard
tour starts, you must first stop the guard tour and re-start it in a different pane.
The guard tour has been set to change layout as it runs. This means that the tour will always start in the first
pane of the selected video window, and cannot be changed.

A guard tour/salvo/sequence starts up when I log in
Control Center has been configured to start up a salvo, guard tour or sequence in a
particular video pane when you log in. To change this, you need to be logged in as an
administrator.

Control Center 5 Troubleshooting



126 Control Center Operator's Guide - v18.1

Salvo/guard tour does not appear where expected
You may have dragged a salvo or guard tour and dropped it onto a video pane, but find that
it starts in the first pane of that window.

If a salvo, this is because it has a layout associated with it. Salvos with layouts always begin in the first pane
of the selected video window.
If a guard tour, this is because its layout is set to change as it runs, according to the properties of the salvos
which it contains. Guard tours which change layout always begin in the first pane of the selected video win-
dow.

Sites

I can't access all devices
You may not be able to find or access a device for the following reasons:

• Your user account may have been allocated particular permissions to allow access
to certain sites and cameras.
For example, you may be able to view and control certain cameras, but not record
video from them, or you may have access to certain sites but not others.

• The device may be in a different segment.
If this is the case, change the active segment.

I can't edit an object
You may not be able to edit an object for the following reasons:

• Your user account may have been allocated particular access permissions to allow
access to certain sites and devices.

• You may be working in all segments mode.
In this mode, the site database is read-only. If this is the case, change the active
segment.

• You may be working with a local site-database cached copy.
Control Center uses a local cached copy of the site database when it cannot contact
either the primary site database or the failover site database, when the user has
been granted permission to cache the site database. Both the failover site database
and local cached copy are read-only.

There's a red X through a device
Control Center makes three successive attempts to contact a device in a site or on the
network. If it cannot contact the device, it displays it with a red X:

A error message is also displayed in the Alerts panel and flagged in the Alarm status bar.

If the device is temporarily unavailable, click to refresh the display.
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Administrators only — If you have permanently removed the device from the network and

want to remove it from the site, select it and click .

All segments mode settings
When working in all segments mode, the following settings are taken from the earliest
created segment that you have been granted access to:

• Audit log settings
• Alarm mode (for example, sound silent, sound once)
• Sort by display name
• Matrix numbering: show numbers
• Matrix numbering: number of digits
• Matrix numbering: include panes

Troubleshooting FrontLine Manager

I cannot find my FrontLine recordings in Control Center
Even if the recordings were successfully downloaded from the FrontLine Camera and
saved to the NVR-AS, a camera wearer may not see their recordings.

When a camera wearer logs in to Control Center they may not see anything in the Video
explorer. This is because all Video explorer items are listed under a site, but the camera
wearer may not have permission to see the site.

To view their recordings, the user should use Site Search (Ctrl + S) to find their camera
wearer.

To view recordings the camera wearer must be in the Playback view. When logging in for
the first time the default view is Live view. The camera wearer must switch to Playback
view to search for their recordings.

FrontLine recordings are not appearing in Control Center
When a FrontLine Camera is docked in a FrontLine Dock, the footage is automatically
downloaded to the NVR-AS installed on the same PC.

If the recordings are not showing up in the Control Center, check the following:

• The NVR-AS installed on the FrontLine Manager PC has been added to your Control
Center site.

• The current playback NVR-AS for the camera wearer is the NVR-AS installed on the
FrontLine Manager PC.

• Ensure the License Server is available on the network and your Control Center
license includes the Body Worn Video feature.

• Ensure the recording was not created with a camera wearer user who had multiple
cameras assigned at the same time.

• Ensure the following services are running on the FrontLine Manager PC:
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• IndigoVision NVR-AS
• IndigoVision FrontLine Interface
• PSS Manager
If any of these services are not running, start them through the Windows Services
utility.
If any of these services fail to start, contact IndigoVision.

• When docked the camera is listed in FrontLine Manager with a status other than
Unknown or In use.
If either of these status items are shown, then the camera has not been detected by
FrontLine Manager.

• Check the amount of space in the NVR-AS video library.
The NVR-AS deletes the oldest recordings in its library if it runs out of space or if the
recordings are older than the maximum age allowed by the reaping policy.

• There may be cameras listed in FrontLine Manager with an error regarding the
available space.
The FrontLine Manager footage directory must be large enough to temporarily store
footage from all of your docked cameras.

• Check FrontLine Manager web interface is running.

The age of recordings from FrontLine Cameras is based on the time the recording was
created, not the time the camera was docked.

• Check the log file for FrontLine Manager interface.
This can be found in the system configuration directory, which defaults to:
C:\ProgramData\IndigoVision\FrontLine Interface\Logs
Look for the username of the camera wearer who recorded footage with the camera.
Any problems transferring the recordings to the NVR-AS are detailed in this log.
Contact IndigoVision if this log file indicates a problem.

Other troubleshooting

Audit log database error

This functionality is only available if you have administrator permissions.

Control Center logs user actions, such as log in, log off, and view recorded video, in an
ODBC compliant database, for example, Microsoft SQL Server.

If Control Center cannot communicate with the audit log database, a warning message is
displayed. When Control Center re-establishes communications, an information message
is displayed.

Control Center may not be able to communicate with the database for the following
reasons:

The database may be off-line or otherwise not contactable.
l Ensure the server database is running, and that the database service is running correctly.
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l Ensure user permissions are correctly configured to allow access to the database.
l Ensure the remote connection configuration of the database server is correctly configured to
allow remote connections.

The database may not have the correct schema.
l Ensure your database schema is up-to-date. All previous audit log databases must be updated to
be compatible with your version of Control Center.
For information about updating your audit log database, click here.

The database does not support the required operations.
l Control Center 3.14 and later versions query the database. Some database solutions do not sup-
port querying of data, for example, text file databases (e.g. .csv). Please upgrade to a database
which does support querying of data, for example, Microsoft SQL Server.
For information about updating your audit log from a text file database, click here.

For more information about setting up and using the audit log please refer to the Audit Log
Reference Guide.

Control Center reacts more slowly than expected

If the CPU indicator at the bottom right of the Control Center interface ( ) turns red, this indicates that your
PC’s processing power is insufficient to view video in this number of panes. Try viewing video in fewer panes
or check that your PC meets the recommended specification: it may require upgrading.
Control Center may be communicating with one or more NVRs. This is indicated by the progress bar in the bot-
tom of the main window.

Overlays do not work as expected
Some laptops and machines running older graphics hardware may experience problems
with video pane overlays. If overlays are not working as expected, you may want to revert
to using the software renderer. This may adversely affect performance.

To use software video renderer:

1. Select Options from the Tools menu.
2. Click the Video and Audio tab.
3. Clear Use software video renderer.
4. Click OK.

Your Operating System may require this change to be authorized.

Why can I see less on an analog monitor than in a PC screen?
Analog monitors using CRT technology do not show the extreme top, bottom, left and right
of any image they display. Different manufacturers exclude different amounts. This
prevents you from seeing the messy edges of the displayed image caused by the cathode
ray scanning horizontally across the screen.

TFT, LCD or Plasma technology monitors are based on discrete pixels and show the full
height and width of the image, making it similar to the image displayed in the video pane.
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Image distorts when the video pane resized
If the video image distorts when the video pane or the window is resized, the Stretch to Fit
aspect ratio is selected.

To disable Stretch to Fit:

1. Select Change Aspect Ratio from the View menu.

2. Select either the Standard or Widescreen aspect ratio.

The aspect ratio of the video panes changes.

I can't export recorded footage for a particular camera
This may be for one of the following reasons:

1. You do not have permissions from your administrator to view video from this camera
2. The camera is unlicensed

Contact your administrator with details of the issue.

If you do not have permissions to export, Control Center displays the following:

• In the Export Status window, the Recording column displays the following message:
! Permission Denied

If the camera is unlicensed, Control Center displays the following:

• In the Video Explorer panel, Site Search window, and any maps the camera is on,
Control Center displays an unlicensed camera icon.

• In the Export Status window, the Recording column displays the following message:
! Permission Denied

► For more information about licensing, see "Licensing Overview" on page 16

I see an error that there is problem with Control Center's license backup
Control Center must be connected to its License Server to operate. If the connection to the
License Server is interupted, for example due to routine maintenance, Control Center will
continue to operate for 30 days.

Control Center maintains a 30-day rolling backup of its license. If connection to the License
Server is lost, then this backup is automatically used. After the connection to the License
Server is restored, Control Center reverts to using the License Server.

If Control Center is unable to back up its license, an error icon ( ) is shown in the status
bar. In this situation, if connectivity is lost with the License Server, Control Center will exit
immediately and not restart until connection is restored.

► For more information about licensing, see "Licensing Overview" on page 16

I see a warning that the Control Center License Server is unavailable
Control Center must be connected to its License Server to operate. If the connection to the
License Server is interupted, for example due to routine maintenance, Control Center will
continue to operate for 30 days.
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Control Center maintains a 30-day rolling backup of its license. If connection to the License
Server is lost, then this backup is automatically used. After the connection to the License
Server is restored, Control Center reverts to using the License Server.

When Control Center is using a backup of its license, a warning icon ( ) is shown in the
status bar, along with the date at which the backup license expires. If Control Center
cannot connect to its License Server before this date, Control Center exits and does not
restart until the License Server is available.

► For more information about licensing, see "Licensing Overview" on page 16
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